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Who Should Use This Manual
Getting Started With WinSales is written for those who are evaluating the program,
novice users just learning how to use WinSales and experienced users who have
upgraded from an earlier version. All users will find this manual useful as a quick
reference guide to basic procedures. The WinSales Training Database is featured in the
illustrations. Step-by-step instructions quickly and thoroughly walk you through basic
operating procedures in a logical sequence.
A separate Administrator’s manual is available for a more in-depth guide to setting up
new and remote databases, synchronization, building queries, reports and exports,
customizing and creating fields and tables and advanced Word Processing functions.

NOTE: It is very helpful to have knowledge of Windows before using WinSales.
You should know how to minimize, maximize, move, resize, activate and close
windows. If you are not comfortable in the Windows environment, it is
recommended that you seek Windows training before working with WinSales.

How This Manual Is Organized
This manual assumes you are new to WinSales 5.0 and must install the program before
use. Installation instructions and Technical Support appear in the first two sections.
(Advanced Installation instructions are located in Appendix A). The following sections
explain the three data Windows you will be working in, how data is entered into each
Window then how to use that data in your daily work. You can follow each section in
order or quickly look up a specific procedure by topic. Once you become familiar with the
program and how it works, the last sections show you how to import your own data into
the system and how to create your own Action Plans.
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Installing WinSales 5.0 Software
Please review the WinSales 5.0 Release Notes.doc for more information on working with
WinSales 5.0. Existing customers will find the new features and functions of WinSales
5.0 in the release notes.

Installation Strategy
We recommend installing WinSales 5.0 to the C:\Program Files\WinSales\ directory on all
client machines with the database existing on a server where users share data. For
companies working with WinSales in a network environment, the software does not need
to be installed on the server where your database resides, only on the local client
machines. When installing the software on client machines we recommend copying the
installation file locally to the machine where you are installing for better performance.
You can copy the installation files to a directory on a server and run the installation from
the network, but the installation will take longer.
Customers working with WinSales 4.0 can have both versions of WinSales installed on a
client machine and running at the same time. You must install the WinSales 5.0 software
on the client machines to a different location than where WinSales 4.0 is located or you
would over write files. By having both versions installed you will be able to use WinSales
4.0 while evaluating WinSales 5.0. Existing customers using remote synchronization
should beware that running synchronization on a copy of their database converted
to WinSales 5.0 without changing the SyncPath will create the same
synchronization files and overwrite existing copies of the 4.0 files in the SyncPath
directory. Change the SyncPath for users in the 5.0 master and remote database
before evaluating remote sync to avoid any issues with the live database!

System Requirements For Installation
Hardware requirements and recommendations - To install WinSales 5.0 you
must have at least 25mb of free space on the hard drive. The minimum machine
requirements are a p200 with 64mb of RAM. We recommend p450 or higher with at least
128mb of RAM.

Win95 requires Outlook 2000 - To install WinSales 5.0 on a Win95 machine
Outlook 2000 must be installed.

Microsoft Data Access Control (MDAC) requirements - WinSales 5.0 will force
the installation of MDAC v2.6 and Jet 4, which requires Microsoft Internet Explorer 4.01
service pack 2 or greater. If users are not currently running IE 4.01 service pack 2 they
will be forced to upgrade before installing WinSales 5.0. To download MDAC v2.6 go to:
http://www.microsoft.com/Data/download_26sp1.htm

Windows 95/98/ME: WinSales 5.0 will install Dcom98. Dcom98 can be downloaded
from http://windowsupdate.microsoft.com/.

Windows 2000 users will be required to have Service Pack 1. However, we strongly
recommend Service Pack 2, which can be downloaded from www.microsoft.com.
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Internet Explorer 5.0 is required for support of WinSales 5.0 features linking to
Internet Explorer. Silent Partner strongly recommends Internet Explorer 5.5, which can be
downloaded from http://windowsupdate.microsoft.com.

Installing WinSales 5.0
Remember to shut down all other programs on the machine before starting the WinSales
5.0 installation. Double click on the file WinSales_Basic.exe to launch the InstallShield
installation wizard that will guide you through the process of installing WinSales 5.0. For
step-by-step instructions on installing WinSales 5.0 please go to Appendix A, More
Information On Installing WinSales 5.0.
Once the InstallSheild Wizard Completed window appears you have successfully
installed WinSales 5.0. Click the Finish button to close the installation program and begin
using the program.
The install creates a shortcut to the WINSALES.EXE on the desktop along with creating
the normal WinSales program group under the PROGRAMS folder where all program
modules may be accessed, as well as the WinSales 5.0 Release Notes. Customers
converting their WinSales database to version 5.0 should use the WinSales 5.0
Conversion Instructions.doc provided in the directory where the program was installed for
step-by-step instructions.

9

Getting Help
Silent Partner provides help in a variety of ways. Some help features assist you with
step-by-step instruction on particular topics, while others provide more general
information. To order or to receive more information about any of the following help
options please contact Silent Partner at www.winsales.com or call 425-483-0125.

Help Menu
Select Help from the WinSales Menu Bar. This contains commands that access various
elements of the Help system including a link to the WinSales Technical Support page on
our website.

WinSales Manuals
The Getting Started manual covers step-by-step instructions on basic user functions of
the WinSales program. The Administrator manual covers advanced features and
functionality. Both manuals are included with the WinSales program so you can print as
many copies as you like. Printed copies can be purchased from Silent Partner.

On-Line Training
Silent Partner has teamed up with Webex to create this unique On-Line Training Center.
This will allow us to meet on the Internet at silentpartner.webex.com and conduct live,
interactive, on-line training sessions. From your PC you can now interact one-on-one
with a certified WinSales trainer.

The Benefits 





A low cost alternative to on-site training
Custom Training - you choose the topics to train on
New Users are up and running quickly
You determine the day and time that will best meet your needs
Training can be conducted on your database

Types of TrainingUser Training: Train on all the aspects of the WinSales module. Entering new Contacts,
scheduling and resolving Activities, working with the Calendar, running Workbench
functions and Reference tables.
Administrative Training: Learn to work with WinSales Administrator, Fulfillment Center
and NetSync. Use the Administrator to create new Activities and fields, modify existing
fields, create security groups and add new Users and sites. Within WinSales, learn to do
imports, exports, advanced Workbench functionality and modify User settings.

Minimum Requirements  Windows 95/98/2000/NT with Pentium processors
 Netscape 4.x or Internet Explorer 4.x
 56k Internet connection - If you are accessing the Internet over your LAN, the
number of users you have connected to the Internet will affect the speed of the
program.
 If you are using Windows NT or 2000, you need to have administrator privileges
when you download the plug-in. Contact your local system administrator for
assistance.
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Self Paced Training Vignettes
Silent Partner offers self-paced training vignettes via our website on an annual
subscription basis. These short “movies” (most are under 5 minutes) demonstrate a wide
variety of WinSales functions and are great for new user training as well as refresher
courses for experienced users. From within the WinSales program, select Help then
Product Support then Training Vignettes then the topic you want to view.

Technical Support
Silent Partner offers the following WinSales support options. An incident is defined as an
issue or problem not the number of phone calls or time it takes to solve it.

 Gold Total Management
Gold Total Management support includes phone and WebEx connected support. At your
request we establish a dial-up connection to your computer using WebEx software and
solve the problem. You can watch while we work! It’s as if we were there with you solving
the problem one step at a time. You see what is wrong and how we fix the problem.
Each connection to address a problem is charged as an incident. With the Gold program
you receive 25 support incidents.

 Silver Care
Silver Care includes WebEx connected support (as with the Gold Total Management
program) providing you with solutions to your WinSales questions via phone or WebEx.
Issues are addressed on a first come first served basis. This program includes 10
support incidents.

 Bronze Assurance
The Bronze Assurance support program is focused on serving the occasional question or
problem. This is not the program to train, customize or fix major database problems.
Issues are addressed on a first come first served basis via phone or email. Includes 5
support incidents.

Website
Go to www.winsales.com and select Support for a list of documents that cover the most
frequently asked questions by topic.
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The WinSales Programs
WinSales
This is the program you will be spending the majority of your time in. It is the
area that contains all the information about your Contacts and their Activities
as well as your Calendar. It will drive your selling processes to help manage
your customers and prospects.

WinSales Administrator
This program is used to modify your database. You can add Users, security,
tables and fields and do routine maintenance on your database. When
making changes to your database you could affect the way the wizard
screens capture data and some changes may not be reversed. If you
choose to modify your database please be sure to follow your manual or check with
Silent Partner first.

Fulfillment Center
This is the program that will help manage your correspondences. It allows
you to send all your scheduled letters, postcards, newsletters, etc from one
convenient location whether by mail, fax or email. After merging is
completed, one click of a button will automatically resolve all scheduled
correspondences and schedule the next step in your Action Plans.

Synchronization
The Synchronization program automates database synchronization with
remote site databases. Each site will run the Synchronization program to
transfer synchronization files automatically at predefined times through a
network or MAPI complaint email systems.

Alarms
The Alarm program allows users to set reminders on WinSales activities. All
WinSales activities have a predefined remind time and when running the Alarm
program users will see pop up windows reminding them when important
WinSales activities are due.

Report Database Utility
The Report Database Utility enables WinSales users to better report on the
information collected in their database. The program creates a normalized data
structure from your WinSales database in Microsoft Access 2000 to be used as a
data source for report writing applications.
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WinSales Short-Cut Keys
FUNCTION

KEY (S)

Activity Log Filter

F7

Activity Log Refresh

Ctrl + F

*

Activity Window

F2

*

Calendar

F3

*

Calendar Refresh

F5

*

Clear Active Window

Ctrl + E

Clear All Windows

Ctrl + L

Contents & Index

F1

Copy

Ctrl + C

Cut

Ctrl + X

Find

Ctrl + F

Import

F9

Internet Search

F12

New

Ctrl + N

Notes Undo Typing

Ctrl + Z

Open Browser

Shift F12

Paste

Ctrl + V

Print

Ctrl + P

Reference Table

F6

Remove From Database

Ctrl + R

Save Active Window

Ctrl + A

Save All Windows

Ctrl + S

Workbench

F4

*

*

*

*

*

* Most frequently used.
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Opening The Database
After installation is complete, start the WinSales program by DOUBLE CLICKING
the WinSales icon that has been placed on your desktop. The program
comes with two databases. One is a “Training” database with mock Contacts
and Activities that will allow you to play with the program and add up to a total of 20 new
Contacts. The other is a blank “Live” database to import or enter your Contacts into and
requires a permanent license to use. To create a training database of your own data, see
Appendix B.
The Live database name will appear in the Database field.
 For the purpose of evaluating or training choose the Training database from the
drop-down list. Otherwise, choose the live database to add Users and import or
enter data.
 User Name type Evaluation

User.
 There is NO Password.
 Select OK.

 In the next window, select any
name from the list of Sales Rep choices. They all work alike.
 Next select any Campaign from the list. You only have to do this the first time
you log into the system.

Note: If you are evaluating or training in the program go to – ‘The WinSales
Database’.
To add Users and Import or enter data go to those respective sections.
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THE WINSALES DATABASE
To open the database see section ‘Opening the Database’.
 Double click the colored Title Bar with the WinSales icon and database name on
it so the window fills your monitor.
Menu Bar

Search Buttons

Title Bar

Message Panel

Current Date & Time

Function Keys

Menu Bar

Contains menu items that allow you to control WinSales'
functions and access other areas of the program.

Search Buttons

The Search Buttons allow you to view the next
previous record retrieved from a search.

Message Panel

Information messages such as the number of records retrieved
in a search or “Entry Saved” are displayed here.

New Button

Prepares the active window for entry of a new record.

Find Button

Executes a search of information entered in the active window.

Save Button*

Saves data entered in the active window.

Clear Button

Clears the contents of the active window.

record or the

*Press SAVE after completing all entries, edits and activities. WinSales
automatically saves most entries but not all of them. Rather than lose data,
make it a habit to SAVE SAVE SAVE everything you do!
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Setting Up Your Work Area – Window Layouts
It is suggested that when you are working with the Contact Window, Activity Log and
Calendar that you have all three windows open at the same time in order to move
effortlessly from one to the other. Below is our recommendation to lay them out.

Position the Windows
When you log into the WinSales database, the Contact window is automatically open in
the position pictured below. Double click the colored bar containing the WinSales
database name to maximize the window to fill your monitor screen.
The Active/Open window is indicated by the colored title bar containing the window
name. In this case it is the Contact window.

 Next, open the Activity Log by selecting it from the View menu or press F2.
 Position the window as shown below.

You will notice that the Activity window is now the Active/Open window as indicated by
the colored title bar and the Contact window is now in the background as indicated by the
gray title bar.
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 Next, open the Calendar window by selecting it from the View menu or press F3.
 Position it as shown below and click the Task tab to view your Task List.
You will notice this is your Active/Open window as indicated by the colored title bar and
that the Contact and Activity windows are in the background as indicated by the gray title
bars.

You can now see all of your windows at once and can move from one to another by
simply clicking your mouse anywhere on the window you wish to work in making it
Active/Open.

Note: Think of these windows as transparencies on an overhead projector.
The window on top is the one you are working in as indicated by the
colored title bar. The other two will be grayed out.
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How It Works
When your Calendar is Active/Open as pictured above, you can double click on the first
item in the Task list and the system will automatically take you to that Activity by
populating the Activity and Contact windows as shown below.
You will notice that the Activity window is now active/open as indicated by the colored title
bar and that you can view all of the Contact information needed to perform the task.
When you Resolve the Activity and press SAVE the system will automatically
activate/open the Calendar window so you can click on the next Task.
 Practice DOUBLE CLICKING scheduled Tasks in the Calendar to see how the
system takes you to the Activity tab and populates the Contact window.
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Print WinSales Windows/Activities
You may print the contents of any WinSales window, (Contact, Activity or Calendar) a
combination of Windows (Contact and Activity) or a single record (Example: Meeting
Activity).
To do so, the Window or Activity you wish to print must be active/open.
 Open the appropriate window and find the record you want to print.
 Choose Print from the File menu.

What Prints
Contact Window - Open the Contact Window and close all other windows. The
contents of all but the Action Plan tab will print.

Contact and Activities - Open the Contact and Activity Windows. Make the Contact
Window active. Display the Activity Log Tab list. The contents of the Contact Window
and Activity Log including notes will print.

Activity Window – Activity Log Tab: The contents of the Activity Log and notes will
print. Activity Tabs: The details of the open Activity and notes will print. If the Activity
is for an individual in a company, the Company Name and the Assigned Rep’s name will
be included.

Calendar Window - The contents of the active tab (Appointment, Planner or Tasks)
will print.
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The Contact Window
What is a Contact? - A Contact is an individual or company in your database whether
they are a customer, client, prospect, suspect, vender, etc. They are somebody have
contact with.
The Contact window is divided into two parts. The top fields in white are embedded into
the program and cannot be altered. The bottom fields in the colored area are changeable
and can be customized for your business. Each Tab along the bottom of the window
holds specific types of information about a Contact and can also be customized.
Note: If you close the Contact window by mistake, go to ViewthenContact to re-open.

Find Existing Contacts
 With a blank Contact window press the Find function button and the system will
bring up all Contacts in the database in the order in which they were entered into
it. (If the window was not blank, press the Clear function button and do not save
changes).

The Message Panel says you are looking at 1 of 10.
 Click the Scroll Buttons
results.

forward and backward to move through the

20

Find A Specific Contact
WinSales will search the database on any window, field and tab you ask it to. Most
searches are done with a Contact’s name or company name. However, you can type in a
phone number, fax number, e-mail address, city, etc and select Find. WinSales will
search the database for the information you requested and bring up all matching results
as indicated in the Message Panel. You can then scroll through the results using the
Search Buttons. The more information you provide WinSales, the narrower the search
will be and the better results it will return.

Note: You do not have to use capital letters when conducting a search using
names, city, state, etc. You do, however, have to use hyphens (-) when
conducting a search using phone numbers. WinSales can only find results on
numbers if the search information is entered EXACTLY the way it appears in the
database. For instance, (425) 483-0125 cannot be found if the search is entered
as 425.483.0125.
 Press the Clear button to return to a blank window.
 Put your cursor in the ‘First Name’ field and type ‘sup’.
 Press the Tab key on your keyboard to move to the ‘Last Name’ field and type
serv then press the Find button.

WinSales found the Contact that matched the information you provided.

Now that there is a Contact in the window, lets look at the information in the tabs and
fields.

Find/Search With Partial Information
There may be times that you don’t have complete information to find something in your
database or you just want to find things that have specific criteria. You can conduct a
search using the percent (%) symbol as a “wildcard” followed by a key word or partial
information to help you. (The % symbol replaces the asterisk (*) symbol used in previous
versions of WinSales).
This method can be used in any field of the Contact and Activity windows as well as the
Condition field in Queries.
See example on next page.
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Find/Search With Partial Information …..Continued
Example:
To find cities with the word “beach” in them:
 Type, “% beach” in the city field on the Contact window then press FIND.

The system will display each Contact with the word beach anywhere in the city field. You
can then use the scroll

buttons to move through the results.

Field Symbols
When you click on a field and see this appear it indicates there is a drop-down
list associated with the field. By clicking on the arrow a list of responses will
display. To ensure consist data entry always make selections from drop-down
lists rather that making freehand entries. This makes reporting more accurate.
The magnifying glass indicates this field is associated with the Reference Table.
DOUBLE CLICKING this symbol displays the Reference Table to give you more
detail about the value in the field. Reference Tables are covered in the manual.

are
field.

These ‘multiple pages’ indicate that there can be Multiple Responses within this
field. When blank, there is no additional information within the field. When there
lines across the pages, it means there is additional information within the
DOUBLE CLICK the symbol to display, edit and add information.
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Profile Tab

 Click on each field to reveal drop-down lists that may be associated with it to
familiarize yourself with their contents. Remember that these field names and
lists can be changed to suite your company’s terminology.

The following are fields that require explanation.
Time Zone

This field auto populates by the State entered in the Contact
window.

Sales Rep

The person in your company assigned to this Contact. The dropdown list shows all Users in your company. Some are in Sales
while others are not. The selection for this field should be the
person assigned to the Contact.

Response Method

How this person or company first came in contact with you. This
information is used in marketing reports to determine what
marketing methods are most effective and which ones are not.

Initial Mktg Campaign*

The Campaign the Contact responded to. Your
company advertises in Newspapers, Magazines, your Website,
etc. Those methods of advertising are your Initial Marketing
Campaigns. There is a choice of ‘None’ in the list if the
Campaign is unknown.

Marketing Detail*

The specific ad the Contact responded to. This field is related to
the Initial Marketing Campaign. If the Contact responded to your
ad in the Wall Street Journal, that is the Marketing Detail for the
Marketing Campaign of ‘Newspaper”. There is a choice of
‘None’ if the Marketing Detail is unknown.

*The purpose of gathering this information is to run reports on where your marketing
dollars are most effective.

Referred By

If someone referred this Contact to you, type that person’s name
here.
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Phones*

This is a Multiple Response field that is able to hold several numbers in
addition to the main number listed in the white area above.

 Double click the Multiple Response symbol
in front of the Phone field to
display the wizard screen.
 From the ‘Choose or Enter Responses’ list on the left, highlight the title of the
number you are going to add. In this example, select 2nd Wk. The choice
appears in the field above the list and your curser will be blinking there. Click
your mouse once and type the number in the field.

 Click ‘Add’ and your new number will appear in the ‘Recorded Responses’ box
on the right. Repeat this step as often as needed.
 If the name of the phone number you are adding is not in the list on the left you
can type it in the blank field above the list followed by the phone number.
 Click OK when you have finished adding all numbers.
You will be returned to the Contact window. The first phone number you entered into the
Multiple Responses wizard will now appear in the Phones field. The symbol will now
have lines going across it indicating that there is information within the field. To display
the additional numbers simply DOUBLE CLICK the symbol and the Multiple Responses
wizard will open.

 To remove or edit a number in this list, DOUBLE CLICK the symbol to open the
wizard.
 Highlight the number you wish to delete or edit.
 The number will appear in the field above the list on the left. Change the number
or select Remove to delete it.
 Click OK when finished making changes.
 Select the SAVE button.
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Honorific

This is a person’s title. If the list does not have the honorific you need
you can type it in. This list can be modified through the Administrator
program to include choices commonly used in your company.

Note: It is very important to make selections from the drop-down list rather than typing
them in. This ensures that data is entered consistently in order that reports are accurate.

Salutation

This is the name that will be used after, “Dear____”, on letters to the
Contact. This may be different than the name that appears in the First
Name field at the top of the Contact window.

Relationship Defines the relationship your company has with this contact. This list
can be customized to the terminology used in your company. You may
use the term ‘Customer’ rather than ‘Client’ for example. Or you may
categorize your Prospects with a numeric or alphabetic system rather
than Cold, Hot and Warm. Changes to all fields and drop-downs lists are
done in the Administrator program.
In this list, ‘Suspect’ is a Contact you have not had a response from yet. This may be a
person or company that was imported into the database from a mailing list.

Customer Type This field can be used for rating Contacts if you choose to. The
dropdown list is alphabetic but can be modified to your own system
through the Administrator program.
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Notes Tab
Enter information of a personal nature about a Contact that is not gathered in the Contact
fields. These are things you can refer to when are talking or writing to them.
Examples: “John loves golf and won his local tournament this year” OR “Has two college
aged children.”

Note: Do not enter notes related to
Phone Calls, Meetings or other Activities
here. Those notes are recorded in the
Activity Window.

Alert Notes
If the note you are entering is something you
want everyone to see each time this Contact
is looked up in the database, you can set an
‘Alert’ that creates a Message window that
pops up. By typing the word ‘Alert:’ as the
first word in the first line on the Notes window, all continuous text you type after the word
Alert: will be included in the Message. When you press the Enter key (carriage return)
the message will be interrupted. Be sure there is a (:) colon after the word Alert or the
Message window will not be created. Click OK in the Message window to close it.
Examples:
“Terry is a male”.
“Reichle is pronounced, ‘Riklie’ “.
“It’s urgent that I talk to Janet when she calls. Find me!”

Note: You may have more than one note in the Notes window but only the
‘Alert:’ note will show in the Message window as long as it is the first note in the
window. The Alert Message will only show the first time you open the Contact
record. The system will reset and display the message again only after you have
opened another Contact record.
 Practice entering Notes and Alert: Notes
on existing Contacts in this database. If
they already have notes just highlight
and delete them then enter your own.
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Organizational Chart Tab
The Org Chart
This tab only works if there is data in the ‘Company’ field. It contains a list of all the
individuals within the company. You can organize and arrange their names in any order
you like by using the arrow buttons at the top of the window. DOUBLE CLICK a name in the
list to populate the Contact window with information for that person.





Find Aardvark Software in the database.
Highlight Julie Platon’s name in the white area.
Press the ‘down’ arrow to move her name.
Press SAVE.

Action Plan Tab
What is an Action Plan?
An Action Plan is a pre-defined series of activities. They can be designed to send
marketing information to prospects as well as keep in touch with existing customers. This
is what Relationship Management is all about and Action Plans automate those
processes for you. An Action Plan could be a once-a-year Birthday or Anniversary card,
a semi-annual newsletter or series of marketing letters and follow up phone calls.

How Do Action Plans Work?
When a Contact is initiated on an Action Plan, WinSales automatically schedules the first
step of the plan to occur. When a scheduled step has been resolved, WinSales
automatically schedules the next step in the plan and so on until the last step of the plan
has been resolved. An Action Plan can consist of one or many steps. A Contact can be
initiated on more than one plan at a time.
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The WinSales program comes delivered with ‘mock’ Action Plans complete with merge
letter templates for you to add your own text to. You can modify them any way you like or
delete them and create your own.
 Click the + in front of each plan to reveal the steps it consists of.
In the example below there are 3 letters and a Follow Up Phone Call.
The >>> symbol in front of the ‘Welcome – New Client’ plan name indicates that this
Action Plan is Initiated.
The >>> symbol in front of ‘New Client Letter 1’ indicates that this step of the plan is
currently scheduled.

Initiate An Action Plan
 With a Contact in the Contact window, highlight an Action Plan name. The
‘Initiate’ button above the Plan name list becomes bold.
 Click the Initiate button and the >>> symbol will appear indicating the plan is now
initiated.
 Press SAVE.

Abort An Action Plan
 With a Contact in the Contact window, highlight the initiated Plan name. The
‘Abort’ button above the Plan name list becomes bold.
 Click the Abort button and the >>> symbol disappears indicating the plan is no
longer initiated.
 Press SAVE.

Note: An Action Plan can be initiated on any step of the plan by simply
highlighting that step then clicking the ‘Initiate’ button.
An Action Plan can be Aborted at any time. For example: A Contact who is on
the 12 Month Delayed Interest plan decides to purchase in 6 months. Abort the
12 Month plan and Initiate the 6 Month plan. Don’t forget to SAVE the change.
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Birthday Card Action Plan
When this plan is initiated a birthday card will be scheduled to send 10 days prior to the
date entered in the Birthday field on the Profile tab. When the Scheduled card is sent
and Resolved, the system will automatically schedule another card for next year.

Database Tab

The Database Tab contains several fields that have to do with the inner-workings of the
program and can be ignored. The fields you will be interested in as a User are:

Entry Date

The date this Contact was entered into the database.

Entered By

Who entered this Contact into the database.

Inactive Reason

Contains a drop-down list of reasons a Contact is no longer an
active prospect. This field can be changed to suite your
company’s terminology.

Inactive By

The person who determined this Contact is Inactive.

Contact ID

The system automatically assigns an ID number to every
Contact as they are entered into the database and uses it to
perform various functions.

Note: By double clicking the Activity tabs in this window the system will take you
to all those Activities linked to the Contact. DO NOT ENTER NEW ACTIVITIES
FROM THE CONTACT’S DATABASE TAB. ALL ACTIVITIES MUST BE
ENTERED THROUGH THE ACTIVITY WINDOW!!!

29

ENTER A NEW CONTACT
There are two types of New Contact entries. You can enter a new company or person
into the database, or add a new person to an existing company. All entries must be done
through the New Contact wizard windows. If you begin typing data directly into Contact
window the system will eventually detect that you are trying to enter a New Contact an
prompt you to use the wizards. The data you typed will not be saved.

New Company or Person
To practice this exercise, enter yourself as the New Contact.
 Start with a Clear Contact window.
 Select the New function button. Page 1 of the wizard screens will display.
 Enter your information in as many fields as possible. Use the Tab Key to move
from one field to another. **
 Select Next or press the Enter key on your keyboard to move to the next screen.

**Note:
-You MUST make selections from drop-down lists whenever possible to ensure
data is entered consistently.
-Be sure to capitalize where appropriate, as the program will not automatically
correct it for you. The way information is entered here is how it will appear on
correspondences to the Contact.
-Use hyphens in phone and fax numbers.
-You can leave the Country field blank for US Contacts.
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Salutation*

This field is automatically populated with the Honorific and Last
Name you entered on the previous screen. This is how
correspondences will be addressed to this Contact. *If you would
like to change the Salutation, highlight it and type the correct
name.

2nd Phone

Enter an additional phone number if there is one.

Job Title

Enter the Contact’s title if you know it.

Job Group

Make a selection from the drop-down list.

Relationship

How is this Contact related to your company? Make a selection
from the drop-down list.

Sales Rep*

This field is automatically populated with the Logged-in User’s
name. This field should contain the name of the person
assigned to the Contact. *Make the correct selection from the
drop-down list of Users.

Response Method*

How did this Contact get in touch with your company? This is a
*required field. If you skip this field and click Next, WinSales will
give you a message stating it is a required field. Make a
selection from the drop-down list.

Marketing Details*

What prompted the Contact get in touch with you? Make a
selection from the drop-down list of advertisements. This is a
required field. If you skip this field and click Next, WinSales will
give you a message stating it is a required field.

 If you selected ‘Customer Referral’ from the Marketing Details drop-down list
WinSales will ask who referred. Enter the name and click OK.
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Contact Notes
 Type something you want to know
about this Contact.
 Click the ‘Set Alert’ box below if you
want this note to appear in a
Message Window each time this
Contact is brought up in the Contact
window.
 Click Next.

The Alert Message window automatically
includes the date and name of the person that
entered the Note. If the message were time
sensitive it can be deleted or updated when the
time has passed. If there is a question about the
Note you know whom to ask.

Next Step Wizard
The Next Step wizard is designed to keep you in touch with your Contacts at all times so
they don’t ‘fall through the cracks’. This wizard is displayed after entering New Contacts
and when you Resolve the Phone Call, Email, Meeting and ToDo Activities. When you
make a Next Step selection WinSales displays a new wizard for that selection then
automatically schedules the Activity you selected.
Typically after entering a New Contact, you would select an appropriate Action Plan that
may be an information packet or prospecting plan or schedule a Phone Call for the
assigned Sales Rep.
There is a choice of None in the list because there are times when a Next Step is not
called for. Next Steps are covered in detail later in this manual.
 For Training purposes, select None.
 Click Next.
 Click Save.
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The wizard screens end and you are returned to the Contact Window which is populated
with the information you entered in the wizard
screens.
 Click through the Profile, Notes,
 Org Chart and Database tabs to see where
your entries went.
 Clear the window then Find your name to
see the ‘Alert: Message’ window.

Add A Name To An Existing Company
You must first find the Company in the database to add the new person to.
 Find the company you want to add a new person to. In this
example use the company you entered above.
 Click the New button and a wizard asks if you are trying to
add a New Company or add to the Same Company.
 Click Same Company.
The same wizard screens will display as before except they are populated with
information pertaining to the Company in the Contact Window so you don’t have to reenter it.
 Go through each blank field and
enter information about the new
person.
 Change existing information if it is
incorrect.
Example: The phone number may be
different for the new person if they have a
direct line and the fax number may be
different if they are in another office.
 Click SAVE when you are finished updating all the
wizard screens.
 Click on the Org Chart tab in the Contact window
to see your new entry.
 Highlight the new name and use the arrows to
reposition the name if needed.
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Duplicate Records
When entering new Contacts, WinSales uses a combination of the phonetic value of the
Company Name and Last Name, the first character of the First Name, and the first three
characters of the address and zip code. If all of these are exactly the same, you are
given the opportunity to add the record as entered, or update the existing ‘duplicate’
record without adding the new record.

The top record is the one you just entered.
If you select ‘Add as Originally Requested’ it will save your new Contact in addition to
the one found in the database.
If you select ‘This is the Same Contact’ you will be asked to verify every new field
entered. Choose the correct value you would like to save. Continue until you reach
the end of the record.

Choose a value
 ‘Other’ is the value that is already in the database.
 ‘Your Value’ is the value you just entered.
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Edit An Existing Contact
Changes can be made to any field on the Contact window as long as the person making
the change has been granted the security rights to do so. Edits are done directly in the
Contact Window. Do NOT select New.
 Find the Contact in the database.
 Enter or edit new data.
 Click SAVE.

Delete A Contact
A Contact can be deleted from the database as long as the person doing the delete has
been granted the security rights to do so. To delete a Contact:
If you are in the Administrator group Find the Contact in the database
 In the Menu bar go to Tools then Wizards then Administrator
 Select ‘Delete Current Contact And Its Activities’
If you are in the User group Find the Contact in the database
 In the Menu bar go to Tools then Wizards then User
 Select ‘ Delete All Activities For A Contact
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The Activity Window
The Activity Window is where all Activities associated with Contacts are scheduled and
performed and where a chronological history of those Activities is displayed.
 Open the Activity Window by choosing ‘Activity’ from the View menu or press F2
on the keyboard.

Window LayoutIn order to see Contact information while working in the Activity Window, it is suggested
that you position the windows as shown below. Once the windows are laid out,
WinSales will remember their positions the next time you log in.

This layout allows you to move between windows easily by clicking your cursor anywhere
on the ‘inactive window’ to make it the ‘active window’. The bold colored title bar
indicates the active window. Think of these as transparencies on an overhead projector.
The one on top is the one you can work in.
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Activity Log Tab
When the Activity window is opened the Activity Log tab is defaulted and will be blank as
shown above. The other tabs in the window are types of Activities.
The oldest record is at the bottom of the list and the newest record is at the top of the list.
The Message Panel tells you how many Activities matched the search for the Contact.

The Activity Log display is divided into two sections. The left displays columns of
information about Activities. The right displays notes for the highlighted Activity. There
is a bar that divides the sections.
 Put your curser on the bar that divides the two sections. When your cursor
becomes a double arrow, click and hold the left mouse button then drag the
mouse to the right until you can see all the columns as shown above. Release
the button.
Note: WinSales may not remember this position next time you open the Activity Window
so you may have to reposition it each time.

Activity Log Columns
+

Indicates that the Activity has Notes associated with it. By clicking once
on the +, the notes display in the Notes section on the right. A fast way
to get an idea of what has occurred with a Contact is to start at the
bottom of the list and click the + in front of each Activity to read the
notes.

Type

A three letter abbreviation of the Activity types shown on the other tabs in
the window.

Date

The date the Activity was Resolved/Cancelled or is Scheduled to occur.

Time

The time the Activity was Resolved/Cancelled or is Scheduled to occur.

Contact

The Contact the Activity is for. It is important to be able to see the
Contact Window at the same time you are working in the Activity Window
to make sure Activities are being recorded for the right person.

SalesRep

The person in your company the Activity is Scheduled for or who
performed the Activity. The ‘SalesRep’ associated with Activities is not
necessarily the Sales Rep assigned to the Contact. Other people may
interact with a Contact and perform Activities with them. Remember, all
Users are called ‘Sales Rep’.
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Campaign

Records the Campaign associated with the Activity. This field helps
keep track of the effectiveness of your Campaigns. For example, you
can pull reports on how many Phone Calls, Meetings, and Sales were a
result of your ABC Magazine ad.

Status

There are three Status types. An Activity is either Scheduled to occur,
has been performed and is Resolved or has been Cancelled.

Reference

Some Activities have fields that populate the Reference column such as
Action Plan letter names and Opportunity closing dates.

Activity Notes
It is important to record notes related to individual Activities in the Notes section of the
Activity. DO NOT RECORD ACTIVITY NOTES IN THE CONTACT WINDOW. It is a
good practice to date and initial your notes in whatever manner you choose. One
recommendation is:
3/14/02…These are my notes about an activity…JE

Undo Notes: This feature only works in the New Activity wizard screen.
 Press Ctrl + Z to Undo Typing just as you can in Microsoft Word.
Once the Notes are Saved you cannot use this feature, You would have to highlight and
delete them.

Display Contact Activities
To view a Contact’s Activities you must first find the Contact in the Contact Window.
 Find the Contact in the Contact Window
 Open the Activity Window from the View menu or press F2 on your keyboard.**
**If the Activity Window is already open to a clear Activity Log tab when you find the
Contact in the Contact Window, the information will automatically populate for the
selected Contact. Make sure the name in the ‘Contact ‘ column matches the name in the
Contact Window.
**If the Activity Window is already open to the Activity Log tab with another Contact’s
information populated in it, click Find to refresh the Log. Look at the ‘Contact column’ on
the Activity Log to make sure it matches the Contact Window.
**If the Activity Window is already open to one of the other Activity tabs, click on the
Activity Log tab then click Find to refresh the Log.

Note: Find acts as the ‘Refresh’ button for the Activity Log. As entries are made
they may not always appear in the Log or they may appear out of sequence until
it is refreshed.

38

Display Activity Details
To view the details of an Activity in the Activity Log list –
 Double click the Activity either in the ‘Type’ column or any other column.
The Activity tab for the item selected will open and display details about the Activity. This
example shows the Tour tab.

Activity Tab Elements
To view the details of an Activity Tab, click on the tab. Activity Tabs are divided into two
sections. The elements of the Activity display on the left and Notes display on the right.
The Phone Call Tab elements are shown here.
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The first seven fields on every Activity Tab are identical. The fields below them are
unique to the selected Activity type.

Contact

The person this Activity is associated with. Be sure this matches
the name in the Contact Window.

Sales Rep

The person who either created the Activity or is scheduled to
perform the Activity. This field has a drop-down list.

Campaign

The marketing project tied to this Activity, This field has a dropdown list.

Date

The date the Activity is scheduled to be performed or was
Resolved/Cancelled.

Time

The time the Activity is scheduled to be performed or was
Resolved/Cancelled.

Status

Indicates whether the Activity is Scheduled, Resolved, or
Canceled. This field has a drop-down list. When a Scheduled
Activity has been performed, select ‘Resolved’ from the dropdown list or press “R” then click SAVE. If the Activity was
cancelled, select ‘Cancelled from the drop-down list or press “C”
then click SAVE.

Mkt Details

The Marketing Details associated with the Campaign. This field
has a drop-down list.
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Create An Activity
There are three ways to create a new Activity for a Contact.
New/Perform Now

Log an Activity that has occurred.

New/Schedule

Schedule an Activity to occur later.

From Next Step wizard

Schedule an Activity by selecting it from the
Next Step wizard.

New/Perform Now
 Find the Contact in the Contact Window
 Open the Activity Window
 Click the Activity type tab you want to log
 Click the NEW button
 Select ‘Perform Now’
Wizard screens will appear for the Activity type you selected.

New/Schedule






Find the Contact in the Contact Window
Open the Activity Window
Click the Activity type tab you want to schedule
Click the NEW button
Select ‘Schedule’.

Wizard screens will appear for the Activity type you selected.

From Next Step wizard
The ‘Next Step’ wizard will appear after entering a new Contact and after clicking SAVE
when an Activity‘s status is Resolved or Cancelled.
In this example a Phone Call Activity has been resolved and the ‘Next Step’ wizard is
displayed.
 Highlight the Activity you would like to schedule
 Click the Next>> button
Wizard screens will appear for the Activity type you select.
The Activity types in the Next Step Wizard are






- Generate Sale
- Schedule Meeting
- Schedule Phone Call
- Schedule ToDo
- Update/Log Opportunity
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Delete An Existing Activity
If an Activity was entered in the wrong Contact record or just entered in error it can be
deleted from the Activity Log.

 Open the Activity you wish to delete by DOUBLE CLICKING it in the Activity Log.
The specific Activity tab must be the active window.

 From the Menu bar select Edit then Record then Remove this “Activity Type”.

WinSales will prompt you that there are no other activities or reference tables associated
and ask you if you’re sure you want to delete this activity. Select YES.
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Correspondence Tab
The Correspondence Tab is used to schedule and send various pieces of
correspondence to a Contact.

Unique fields in the Correspondence tab
The Method field shows how a Correspondence is to
be delivered. It is a drop-down list that can be revised
through the Administrator.

The Letter field shows which piece of
Correspondence is to be sent. It has a drop-down list
of letters in your letter directory. The items shown
here are delivered with the program. As you create
your own letters you can add them to the list through
the Administrator.

Subject is for Correspondence
sent via E-Mail. The text in this field
will appear in the subject line on the
recipient’s email.

Attachment is for Correspondence sent via E-mail and is the path name for an
attachment you want to send.

Enclosure 1 – 9 is a list of items to be sent with a
Correspondence. These are examples that come with the
program. The list of choices can be modified through the
Administrator.
CorId is an identification number the system automatically
assigns each Activity. You can ignore this number.
Notes tell you what the Correspondence is about.
When building Action Plans, Notes are typed in
the Activity Template and will display here. If the
Correspondence is a Custom letter, you can copy
the body of the letter from Word and paste it here.
Alternatively, type a brief summary of the letter.
Now you know what the letter said.
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Send A Correspondence
To send a Correspondence from the Activity Window rather than the Fulfillment Center:






Find the Contact in the Contact Window
Open the Activity Window
Click the Correspondence Activity tab
Click the NEW button
Select ‘Perform Now’

Correspondence wizard screens -

 Select a Letter name from the drop down list.
 Select a delivery Method from the drop down list.
 Select the Sales Rep the letter should be signed by from the drop down list if
different than the person in the field. (The logged-in User name defaults here)
 Select the Marketing Details if different than the default in the field.
 Check the ‘Check to Add Enclosures’ box if appropriate.
 Click Next

‘Add Enclosures’ wizard









Add Enclosures by DOUBLE CLICKING the items on the left.
Click [Other] if the item is not in the list.
Type in the name of the [Other] item in the 2nd wizard that displays and click OK.
If there is more than one [Other] item, repeat the step above.
Click Next when the list on the right is complete.
When the wizard screens disappear, click SAVE.
The Status automatically defaults to ‘Resolved’.

Check the Message Panel to be sure
the Correspondence Activity is saved.
Note: There is no Next Step Wizard on Correspondence Activities
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Print/Send From Correspondence Activity
For delivery Method of ‘Mail’
•
•
•
•
•
•
•

Double Click the Letter icon to launch Word.
Type the body of the letter if it’s a Custom letter.
Print the letter (File then Print).
Highlight the body of the letter and Copy (Ctrl + C).
Close Word and DO NOT SAVE when asked or you will over write the letter
template. You will be returned to the Correspondence Activity.
Place your cursor in the white Notes section and Paste (Ctrl + V).
Click SAVE.

For delivery Method of ‘Fax’
If you type a message on the Fax Cover Sheet that you want to record in WinSales –
Select Fax Cover.doc in the Letter field drop-down list.
Double Click the Letter icon to launch Word.
Type your message.
Print the letter (File then Print).
Highlight the message and Copy (Ctrl + C).
Close Word and DO NOT SAVE when asked or you will over write the letter
template. You will be returned to the Correspondence Activity.
 Place your cursor in the white Notes section and Paste (Ctrl + V).
 Click SAVE.
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For delivery Method of ‘E-Mail’
Email works differently than Mail and Fax in that it does not launch Word to allow custom
letters to be written. Instead, WinSales will send the email via your email service. Only
pre-written letters that are in the Letter drop-down list can be sent from the
Correspondence Activity.
Select the document you wish to send from the Letter field drop-down list.
Enter text in the Subject field for the recipient’s email.
Enter the Attachment path if sending an attachment.
Type a summary of what the Letter and Attachment said in the Note section. If
the letter is part of an Action Plan, this will be done.
 DOUBLE CLICK the Letter icon to send the email.
 Check the Message Panel to be sure the email was sent.
 Click SAVE.





Send A Scheduled Correspondence.
There may be times that you want to send a Scheduled Correspondence from the Activity
Window rather than the Fulfillment Center.





Follow the steps outlined above for the Method type.
Highlight the Status field.
Select Resolved from the drop-down list or press ‘R’ on the keyboard.
Select SAVE.

Schedule A Correspondence
To schedule a Correspondence to be sent at a future date 





Find the Contact in the Contact Window.
Open the Activity Window.
Click the Correspondence Activity tab.
Click the NEW button.
Select ‘Schedule’.

A calendar screen will display for you to select the date
the letter should be sent.
 Select the month, day and year
 Click OK.
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The same wizard screens will display as in Send A Correspondence above.
 Fill out each wizard screen.
 If Method is Email, be sure to enter text in the Subject and Attachment fields.
 Select SAVE.
Your letter is now scheduled to be printed in the Fulfillment Center.

Email Tab
The Email tab is used to record emails sent to and received from Contacts by copying
and pasting email text into the Notes section. This allows you to have a record in
WinSales so you don’t have to look in your email program. To send an email through
WinSales, use the Correspondence Activity.







Highlight the text of your ‘Sent’ or ‘Received’ email.
Copy the highlighted text (Ctrl+C).
In WinSales find the Contact in the Contact Window.
Open the Activity Window.
Click on the Email Activity tab.
Click the New button and select Perform Now.

The first wizard screen is defaulted to the current date and time, the logged-in User’s
name in the Sales Rep field and the current Marketing Details.
 If the default fields are correct, click Next.
 If the default fields are incorrect make the correct selections from the drop-down
lists then click Next.
The second wizard screen is the Notes section.
 Click your cursor in the Notes section, type today’s date and press Enter to move
the cursor to the next line.
 Paste (Ctrl+V) the copied email text.
 Click Next.
You will be returned to the
Email Activity window.
 Click SAVE.
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The Next Step wizard will display.
 Highlight the Next Step you want to
schedule.
 Click Next.
 Fill out the wizard screens for the Next
Step you selected.
When the wizard screens are complete the Email Activity window will display again.
 The Status field will default to Resolved.
 The Next Step field will default to the
selection you made.
 The Date Entered and Entered By fields
will default to the current date and the
logged-in User name.
 The system will assign ID numbers to
the Activity record. Ignore these.

Meeting Tab
Unique fields -

Purpose is a drop-down list of choices
that can be modified in the Administrator
program.

Location is a drop-down list that pulls
address information based on the
selection or allows a custom entry.

The location address and phone
automatically populates the next fields
based on the selection in the drop-down list.
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Attendees is a multiple response field that allows several entries. This is a list of
everyone who will be attending the Meeting.

the Attendees icon to view the
list. This list can be modified at any time.

OUBLE CLICK

Log/Schedule A Meeting
The Meeting wizard screens are the same whether the Activity originates from a Next
Step selection, New/Schedule or New/Perform Now. When originating from a Next Step
selection, the wizard screens automatically display.








Find the Contact in the Contact Window.
Open the Activity Window.
Click the Meeting Activity tab.
Click the NEW button.
Select ‘Schedule’ if the Meeting is to occur later.
Select ‘Perform Now’ if it has already occurred.

Date/Time
Page 1 - When scheduling a Meeting, the date and time will default to 7 days from the
current date at 7:30am. When logging a new Meeting that has already occurred (not
previously scheduled) the date and time will default to the current date and time.
 Enter the correct Meeting Date and Time.
 Select the Sale Rep who is to attend the Meeting from the drop-down list. (The
logged-in User’s name is defaulted)
 Select Marketing Details from the drop-down list if different than the default.
 Select a Purpose from the drop-down list.
 Select a Location from the drop-down list.
 Click Next.

49

Meeting Address
Location – [Other]
When the Location selection on
Page 1 is [Other], the fields on Page
2 will be blank. Enter as much
information as possible.

Location – Client Site
When the Location selection on
Page 1 is ‘Client Site’, Page 2 is
populated with the address and
phone number in the Contact
Window. Verify the information and
click Next.

Location – Our Site
When the Location selection on
Page 1 is Our Site, Page 2 is
populated with your company
address if you entered it in the
Administrator**. If not, enter the
information here and click Next.

** See “User Settings – Personal Tab” in the Administrator manual for instructions to
enter an “Our Site” location default.
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Attendees
Page 3 allows you to add names to the ‘Currently Attending’ list. The ‘Currently
Attending’ list automatically pulls the Contact name from the Contact Window and the
Sales Rep name from Page 1 of the Meeting wizard for you.
 If the Contact and Sales Rep are the only Attendees, click Next.

 If others will be in attendance, put your cursor in the ’New Attendee’ field.
 Type the name of the New Attendee then click Next. The name will appear in the
‘Currently Attending’ list.
 Repeat this step for each additional Attendee.
 When the ‘Currently Attending’ list is complete, leave the ‘New Attendee’ field
blank and click Next.
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Meeting Notes
Page 4 - Notes are very important and are used in two ways.
1. To convey information to the Sales Rep prior to the Meeting so they know exactly
what the meeting is for and what they have to do. Remember, a Meeting can be
scheduled several days or weeks in advance so reminders are helpful.
2. To log what occurred in the Meeting after it has been Resolved.
 Enter Notes and click Next.
 If scheduling a Meeting, the wizard screens will end and the Meeting Activity
window will display. Click SAVE.

 If logging a Meeting that already occurred, the ‘Next Step’ wizard will display.
Make a selection, click Next then fill out the wizards for the selection you made.
 When the wizards end the Meeting Activity window will display. Click SAVE.
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Resolve/Cancel A Scheduled Meeting
 Find the Contact in the Contact Window
 Open the Activity Window.
 From the Activity Log tab, find the Scheduled Meeting Activity in the list.
(Look at the Date, Time and Status columns).
 DOUBLE CLICK to open the Meeting Activity tab.
 - Or  DOUBLE CLICK the Scheduled Activity in your Calendar’s Task List.

 Enter your notes in the Notes Section. It is suggested that these notes be
positioned above other notes so the current ones are always on top.
 Change the Status from Scheduled to Resolve or Cancelled.
 Select SAVE.
 Make a ‘Next Step’ selection and fill out the wizard screens of the selection you
made.

Opportunity Tab
An Opportunity Activity helps manage what is in your sales pipeline and is a tool for sales
projections. An Opportunity can be scheduled from a ‘Next Step’ selection or by clicking
the Opportunity Activity Tab.

Unique Opportunity fields –
Stage has a drop-down list to describe where the
Contact is at in the closing process. This list can
be modified through the Administrator.

Close% has a drop-down list to indicate how far
the Contact is to closing the sale. The numbers in
the list can be modified through the Administrator.

Close Month has a drop-down list to select from.
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Product is a drop-down list of your products or
services. The items in this list are entered through
the Reference Table as indicated by the
magnifying glass in front of the field name.

Amount is the total expected amount of the sale.
This field cannot calculate totals.
Lost Reason is for those very rare occasions
when an Opportunity is cancelled. The
information can be used to determine why sales
don’t close so possible adjustments can be made
within your company. The list can be modified
through the Administrator.

Lost To is a list of your competitors that is
entered through the Reference Table. This
information allows you to determine how you stack
up to your competition.

Schedule An Opportunity






Find the Contact in the Contact Window.
Open the Activity Window.
Click the Opportunity Activity tab.
Click the NEW button.
Select ‘Schedule’.

 Select the Month, Day and Year
the pending sale is likely to
close.
 Click OK.
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Page 1 - Date and Time will default to the date selected on the calendar and the current
time. Sales Rep is defaulted to the logged-in User. Marketing Details is defaulted to
what is on the Contact window.










Verify Date and Time. Make changes if needed.
Verify Sales Rep and make a change from the drop-down list if needed.
Verify Mkt Details and make a change from the drop-down list if needed.
Select a Product from the drop-down list.
Type the total estimated sale Amount. You do not have to type the $ sign,
commas or (.) point. The system will add them into the Activity window.
Select the estimated closing Month from the drop-down list.
Select what Stage they are at from the drop-down list.
Select the Close%.
Click Next.

Page 2 – Notes may be about issues the Contact may have or special points that you
may want to refer back to in your selling process.
 Enter Notes about the Opportunity.
 Click Next.
The wizard screens end and the Opportunity tab window will display.
 Click SAVE.
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Update An Opportunity
In order to update a scheduled Opportunity the function must be originated from a ‘Next
Step’ selection of ‘Update/Log Opportunity’. This is because you would not know an
update is needed unless you were notified by phone, from a meeting or another Activity.
When that Activity is logged and saved you are prompted for a ‘Next Step’ at which time
you may choose to update the Opportunity.

 From the Next Step wizard select Update/Log Opportunity.
 In Opportunity Information – Page 1 DOUBLE CLICK the Opportunity you want to
update. There may be more than one.

The Opportunity wizard screen will display with the current information.
 Update the appropriate fields.
 Click Next.
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-The notes of the previous Activity from which you selected ‘Update Opportunity’ as the
‘Next Step’ display on the left.
Notes previously entered in the Opportunity Activity display on the right.
 Highlight and Cut (Ctrl + X) the ‘Activity Notes’ and Paste (Ctrl + V) them into the
‘Opportunity Notes’ section.
 Click DONE.

•
•

Find the scheduled Opportunity in the Activity Log window.
Open the Activity by double clicking or just click the + on the Activity Log to view
the Notes section.
The notes you pasted now display in the Opportunity Activity Notes section.
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Resolve An Opportunity
An Opportunity can be Resolved in two ways - by selecting ‘Update/Log Opportunity’ as a
‘Next Step’ or in the Opportunity tab window.
From Update/Log Opportunity Wizard

 Click your mouse in the ‘Resolve this opportunity’ box then click Done.
The Opportunity List window will display. The Resolved Opportunity will have been
removed from the list.
 Click the Finished button.

The ‘Next Step’ wizard will display

 Choose a Next Step of
‘Generate Sale’ if it’s
appropriate.
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From Opportunity tab window
 Find the Contact name in the Contact window.
 Open the Activity window.
 Find the Opportunity in the Activity Log. DOUBLE CLICK it to open the Opportunity
window.
 Change the ‘Status’ field from Scheduled to Resolved.
 Enter Notes if needed and click SAVE.

A wizard will display asking if you would like to generate a Sale. If you click Yes, there
will be a series of ‘Sale’ wizard screens to fill out.

Cancel An Opportunity
Canceling an Opportunity can only be done in the Opportunity tab.

 Find the Contact name in the Contact window.
 Open the Activity window.
 Find the Opportunity in the Activity Log. DOUBLE CLICK it to open the Opportunity
window.
 Change the ‘Status’ field from ‘Scheduled’ to ‘Cancelled’.
 Make a selection from the ‘Lost Reason’ drop-down list.
 Make a selection from the ‘Lost To’ drop-down list if needed.
 Enter Notes if needed and click SAVE.
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Phone Call Tab
The Phone Call tab is used to log inbound and outbound calls with a Contact. A Phone
Call Activity can either be initiated from a ‘Next Step’ wizard or from the Activity window
by selecting New /Schedule or New/Perform Now.

Unique fields in the Phone Call tab –
Call Type indicates whether the call was
Inbound or Outbound. Use the drop-down list to
make a selection.

Call Purpose comes with a drop-down list of
choices that can be modified in the
Administrator.

Result indicates what happened with the call.
The drop-down list can be modified in the
Administrator.

Duration is a field you can use if you track the
time you spend on phone calls. You must
calculate this number outside of WinSales.
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Log/Schedule A Phone Call
The Phone Call wizard screens are the same whether the Activity originates from a Next
Step selection, New/Schedule or New/Perform Now. When originating from a Next Step
selection, the wizard screens automatically display.







Find the Contact in the Contact Window.
Open the Activity Window.
Click the Phone Call Activity tab.
Click the NEW button.
Select ‘Schedule’ if the Phone Call in to occur later.
Select ‘Perform Now’ if it has already occurred.

When you select New/Schedule a calendar window will display.
 Select the Month, Day and Time.
 Click OK.

Note: If it doesn’t matter what time of day the call is made, schedule it for a non-working
hour so as not to clutter the caller’s calendar. Working-hour time slots should be kept
open for Activities that must be done at a particular time.
Page 1 –
If the Activity was initiated from New/Schedule  Confirm the date and time you selected from the calendar window.

If the Activity was initiated from New/Perform Now or ‘Next Step’ wizard -

Date and Time will default to the
current date and time.
Sales Rep will default to the
Logged-in User name.
Marketing Detail will default to the
Value in the Contact window.
Call Type will default to Outbound.
 If the default fields are correct, click Next.
 If the default fields are incorrect make the correct selections from the drop-down
lists then click Next.
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Page 2 - Notes
 Click your cursor in the Notes section, type today’s date and enter notes.
 If this is a ‘Scheduled Call’, enter notes that will tell the caller what the call is
about.
 If logging a call that has already occurred, enter notes that tell what was
discussed.
 Click Next.

The wizard screens end and the Phone Call tab displays.
 Click SAVE.

Next StepIf the call was initiated from New/Perform Now, the ‘Next Step’ wizard will display so you
can make a selection.
 Make a selection from the Phone Call Result list.
 Choose a Next Step then click OK and fill out the wizard screens for the selection
you made.
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Resolve/Cancel A Scheduled Phone Call
 Find the Contact in the Contact Window
 Open the Activity Window.
 From the Activity Log tab, find the Scheduled Phone Call Activity in the list.
(Look at the Date, Time and Status columns).
 DOUBLE CLICK to open the Phone Call Activity tab.
 - Or  DOUBLE CLICK the Scheduled Activity in your Calendar’s Task List.

 Change the Status field from Scheduled to Resolved or Cancelled.
 Enter Notes about the Phone call if the phone was completed.
 Click SAVE.

A ‘Next Step’ wizard will display to make a selection from.
 Make a selection and fill out the wizard screens for that selection.

The Next Step field on the Phone Call Activity window will automatically populate the
selection you made.
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Sale Tab
Unique fields
Product is a drop-down list of your
products or services. These are
entered into the list through the
Reference Table.

Sale Amount is the final amount of a
‘Resolved’ Sale or the estimated
amount of a ‘Scheduled’ (pending)
Sale.

Log/Schedule A Sale
A Sale can be generated directly from the Sale tab or by resolving a scheduled
Opportunity (See Opportunity Tab). The Sale wizard screens are the same whether the
Activity originates from a Next Step selection, New/Schedule, New/Perform Now or a
resolved Opportunity. When originating from a Next Step selection, the wizard screens
automatically display.







Find the Contact in the Contact Window.
Open the Activity Window.
Click the Sale Activity tab.
Click the NEW button.
Select ‘Schedule’ if the Sale is to occur later.
Select ‘Perform Now’ if it has already occurred.

When you select New/Schedule a calendar window will display.
 Select the Month, Day and Time.
 Click OK.

Note: If it doesn’t matter what time of day the call is made, schedule it for a non-working
hour so as not to clutter the caller’s calendar. Working-hour time slots should be kept
open for Activities that must be done at a particular time.
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Page 1 - Date and Time will default to the date selected on the calendar and the current
time. Sales Rep is defaulted to the logged-in User. Marketing Details is defaulted to
what is on the Contact window.
Verify Date and Time. Make changes if needed.
Verify Sales Rep and make a change from the drop-down list if needed.
Verify Mkt Details and make a change from the drop-down list if needed.
Select a Product from the drop-down list.
Type the total estimated sale Amount. You do not have to type the $ sign,
commas or (.) point. The system will add them into the Activity window.
 Select the estimated closing Month from the drop-down list.
 Click Next.






Page 2 - Notes
 Click your cursor in the Notes section, type today’s date and enter notes.
 If this is a ‘Scheduled’ Sale, enter notes that will remind you what has to happen
before the Sale can close.
 If logging a Sale that has already occurred, enter whatever you think is pertinent.
• Click Next.
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The wizard screens end and the Sale tab window displays.
 Click SAVE.

If the Sale was initiated from New/Perform Now, the ‘Next Step’ wizard will display for you
to make a selection from.
 Choose a Next Step.
 Click your cursor in the ‘Initiate New Client Plan?’ box if you want to automatically
initiate this Action Plan. Note: This is a feature you can choose to use or not.
You must have content in the Action Plan template.
 Click Next and fill out the wizard screens for the selection you made.
When the wizard screens end the Sale tab window will display.
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If you checked the ‘Initiate New
Client Plan?’ box on the Next Step
wizard screen, WinSales has
automatically initiated the Action
Plan for you.
To verify this click on the Contact
window to make it ‘Active’. - Then
click the Action Plan tab at the
bottom of the window.
There are chevrons >>> in front of
the ‘Welcome – New Client’ Action
Plan indicating it is initiated.

Resolve/Cancel A Scheduled Sale
 Find the Contact in the Contact Window
 Open the Activity Window.
 From the Activity Log tab, find the Scheduled Sale Activity in the list. (Look
at the Date, Time and Status columns).
 DOUBLE CLICK to open the Sale Activity tab.

 Enter your notes in the Notes Section. It is suggested that these notes be
positioned above other notes so the current ones are always on top.
 Change the Status from Scheduled to Resolve or Cancelled.
 Select SAVE.
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 Make a ‘Next Step’ selection.
 Click your cursor in the ‘Initiate New Client Plan?’ box if you want to automatically
initiate this Action Plan. Note: This is a feature you can choose to use or not.
You must have content in the Action Plan template.
 Click Next and fill out the wizard screens for the selection you made.
When the wizard screens end the Sale tab window will display.

68

ToDo Tab
The ToDo tab is used to remind yourself or others to do something pertaining to a
Contact. A ToDo Activity can either be initiated from a ‘Next Step’ wizard or from the
Activity window by selecting New /Schedule or New/Perform Now.

ToDo Examples
-Gather requested information
-Make sure deposit arrived
-Check status of project
-Buy a gift/Send flowers
-Decide next course of action

Log/Schedule A ToD0
The ToDo wizard screens are the same whether the Activity originates from a Next Step
selection, New/Schedule or New/Perform Now. When originating from a Next Step
selection, the wizard screens automatically display.







Find the Contact in the Contact Window.
Open the Activity Window.
Click the ToDo Activity tab.
Click the NEW button.
Select ‘Schedule’ if the ToDo in to occur later.
Select ‘Perform Now’ if it has already occurred.

When you select New/Schedule a calendar window will display.
 Select the Month, Day and Time.
 Click OK.

Note: If it doesn’t matter what time of day the ToDo is done, schedule it for a nonworking hour so as not to clutter the caller’s calendar. Working-hour time slots should be
kept open for Activities that must be done at a particular time.
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Verify that the Date and Time fields are correct.
Verify that the Activity is scheduled for the correct Sales Rep.
Change the Marketing Details if needed.
Enter Notes that tell the Rep what to do.
Click Next.

The ToDo Activity window will display.
 Click SAVE.
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Resolve/Cancel A Scheduled ToDo
 Find the Contact in the Contact Window
 Open the Activity Window.
 From the Activity Log tab, find the Scheduled 2Do Activity in the list. (Look at the
Date, Time and Status columns).
 DOUBLE CLICK to open the ToDo Activity tab.
 - Or  DOUBLE CLICK the Scheduled Activity in your Calendar’s Task List.

 Enter your notes in the Notes Section. It is suggested that these notes be
positioned above other notes so the current ones are always on top.
 Change the Status from Scheduled to Resolve or Cancelled.
 Select SAVE.
 Make a ‘Next Step’ selection and fill out the wizard screens of the selection you
made.
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Activity Log Filter
What It Does
This allows you to display specific Activities in the Activity Log window based on
selections made.
 Select ‘Activity Log’ from Search on the Menu bar or press F7 on the keyboard.

Sales Rep

Defaults to All or a selection can be made from the dropdown list.

Campaign

Defaults to All or a selection can be made from the dropdown list.

Date

A specific date or a date range may be entered here. To
enter a date range use a comma (,) to separate the
beginning and ending dates.
Example: 10/1/01 , 10/2/01

Status

Defaults to All or a selection can be made from the dropdown list.

Activity Type

Defaults to All or a selection can be made from the dropdown list.

Displayed Contact Only

This is the default. You must first have a Contact
displayed in the Contact window before opening the
Activity Log Filter to make this selection. WinSales will
only search for that Contact’s records.

All Contacts

You do not need a Contact displayed in the Contact
window to make this selection. However, if there is a
Contact displayed in the Contact window, WinSales will
still search all Contact records in the database.

Displayed Company Only

You must first have a Company name displayed in the
Contact window before opening the Activity Log Filter to
make this selection. WinSales will search for all Contact
records within that company regardless of the name in
the First and Last name fields.
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Conduct An Activity Log Search






Find the Contact you want to conduct the Search on in the Contact Window.
Open the Activity Log Filter (F7) or Search then Activity Log in the Menu bar.
Make selections in the Activity Log window fields.
Click OK.

The Activity Log will display the results of your search.
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The Calendar Window
Access the Calendar window from the View menu or press F3 on the keyboard. The
Calendar is a very important feature of WinSales. The Task List shows all your
scheduled Phone Calls, Meetings/Appointments and ToDo’s and is the vehicle by which
those Activities will be performed and Resolved. The Calendar will literally drive your
day. Activities not shown in the Calendar are Correspondence, Sales and Opportunities.

Today’s date is defaulted in the monthly calendar.
on either side of the Month
 To view another date click the scroll buttons
and Year.
 When you reach the desired month, click the day you wish to view.

Calendar Windows
Appointments
This window is a day-at-aglance view.
Planner
This window is a week-at-aglance view.
Tasks
This window displays a list
of scheduled Activities for
the logged-in User.

Activities Show In Feature
In the WinSales Administrator each Activity type can be set to show in the Calendar or
the Task List. Typically those Activities are Phone Calls, Meetings/Appointments and
ToDo’s.

74

Appointment Window
The Appointment window shows scheduled Activities for the person logged into the
database. The right-hand section displays a monthly calendar. The left-hand section
displays time slots showing scheduled activities for the selected date. There are 7
columns (3 are shown below). To view all 7 columns, click the left edge of the window
and drag it to the left. The Calendar always defaults to the current dateThe first name of
the Contact the Activity is for displays in the time slot.
 To see what the Activity is, DOUBLE CLICK the Contact name and the system will
open the Activity tab.
An X in a time slot is tied to the person whose name appears above it.

When there is more than one Activity scheduled in the same time slot the Contact’s first
name will display in the time grid as shown below. You will most likely see this occur
when activities are scheduled for non-working hours because there is no specific time of
day that they must be performed. Commonly these are Phone Calls and ToDo’s.
 To see the details of Activities, DOUBLE CLICK the name and the Activity tab will
display.
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Planner Window
The Planner window is a week-at-a-glance view of scheduled Activities for the person
whose name is selected in the User List in the lower right side of the window. It will
default to the logged-in User. This is especially useful when you are scheduling Activities
for other people so you can view their availability.
 Simply click a name in the User list.
 Select the Month and Day in the monthly calendar in the upper right.
The hash marks in the time slots on the left indicate a scheduled Activity.

View Activity Details
 Click on a hash mark and the Message Panel will display the Activity Type,
Contact’s last and first name and a portion of the Activity Notes.
 DOUBLE CLICK the hash mark and the system will open the Activity tab.
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Task Window
The Task window contains the Task List, which is a chronological list of the scheduled
Activities of the logged-in User. This window is designed to drive your day and should be
the only method by which scheduled Activities are performed and resolved.

How it works
Open the Task List first thing every day and browse through each item. Priorities can be
set at that time if you choose to use that feature.
 Highlight an item and click the Details button or DOUBLE CLICK to open the Activity
tab.
 Perform the Activity, enter Notes, change the Status from Scheduled to Resolved
and click save.
 Choose a Next Step and fill out the wizard screens for that selection.
 The Task List will display again so you can open the next Activity in the list.

Task List columns can be sorted ascending by clicking the column button
or descending by control + clicking.
Type

The Activity type. Click this button to sort the list by Type.

Priority

The level of Priority for the Activity. Click this button to sort the
list by Priority

Due Date

Dates are defaulted to ascending order. Click this button to resort the list if it becomes out of order

Description

Contact first and last name and Notes display here.

Print

Print window.

Details

Highlight a Task then click Details to open the Activity tab.
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Task List Size
The program is pre-set to display 365 days worth of items in the Task list. You can re-set
it to display any number of days. All scheduled items through the last day selected will
display.

Example: If today is Jan 1st and you only want to display Tasks scheduled for
today, re-set the calendar to display 1 day. If you still have scheduled Activities
dated prior to today, those Activities will display in addition to today’s items.
 From the WinSales Menu Bar select Options then Modify then User Settings.
Select the Calendar tab as shown below.

TaskLookAhead

This determines the number of days worth of Tasks that will
display in the list. It is defaulted to 365 but can be modified by highlighting and changing
the number in the New Setting field on the right. Select SAVE if you make a change.

Print Calendar Windows
Clicking the PRINT button on the Planner and Task Windows will display the
Calendar Print Options window. From the Appointments tab you must select File –
Print to display the window.
 Select the Print, Style
and Size you want and
click OK.

What Prints?
Weekly Planner A single sheet showing Sunday through Saturday with Contact name
and partial Activity notes in time slots running from 8:00am – 6:00pm.
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Daily Planner Seven sheets, one for each day of the week, showing Sunday through
Saturday with Contact name and partial Activity notes in time slots running 8:00am –
8:00pm.
Note: Activities that are scheduled in time slots other than those printed on the sheet will
print at the top or bottom of the page.

Priorities and Reminders
To set a Priority or Reminder on an item in the Task List:
 Press and hold the Ctrl key and DOUBLE CLICK the Task in the list at the same
time.

The above Task window will display.
 Fill in the Reminder and Priority fields then click OK.
 If setting a Reminder you must open the Alarm program. To do so, follow the
steps on the next page under Set Alarms.

Note: You can decide for yourself what system you want to use for Priorities. It
may be numeric or alphabetic.
Note: Please refer to the Calendar section in the Administrator manual for
instructions to set the Alarm program for Reminders.
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Set Alarms
The Alarm program allows users to set reminders on WinSales activities with message
windows telling them when important WinSales activities are due.

Open Alarm Program
 From WinSales select the Tools menu then Alarms.
 Log into the database as you normally do and click OK.
 Minimize the Alarm window.

The Alarm icon will be placed on the bottom of your monitor so you know it is running.

Set Reminder
 Set Reminders on those Task list items you wish to see a message windows for.
See instructions on the previous page for Priorities and Reminders.

At the specified time a beep will sound and the Alarm message window will appear on
your monitor with the Task item(s) you asked to be reminded of.

 Highlight the Task
 Press Dismiss if you want to turn off the Alarm for that item.
 Press Snooze if you want to be reminded again at the pre-set interval. See
Calendar User Settings.
 Press Details to see more information about the item.
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Alarm Details
 Click OK after viewing the details.
 To Resolve the Task you must DOUBLE CLICK the item in the Calendar Task
list and Resolve it from the Activity tab.

Close Alarm Program
 Right mouse click the Alarm icon in the lower right corner of your monitor and
click EXIT.
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Schedule Non-Contact (Personal) Activities
The system will allow Activities to be scheduled through the Calendar that are not tied to
a Contact in the database. This feature can be used to schedule personal stuff that will
show up in Task list.

 With a clear/blank Contact window, select either the Appointment or Planner
tab in the Calendar.
 Select the date and time you wish to schedule the Activity for and click Edit OR
DOUBLE CLICK the time slot.
 In the New Appointment window type a note in the Description area.
 Select the Type of Activity from the drop-down list.
 The Start Date and Time will default to the selection made in the calendar.
 Enter an End Date and Time if needed. Otherwise, leave the default, which is
the same date and 30 minutes after the Start Time.
 Set a Reminder if needed and press OK.

The scheduled Activity will appear in the Task list like all other activities except there is
no Contact name in the Description column.
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The Workbench
The Workbench is used to conduct database searches, design and print reports, conduct
mail merges, graph statistics, export information out of the WinSales database and to
mass assign Contacts to Action Plans.
Your WinSales database comes with pre-defined Workbench tools that you can use as is,
modify to better suit your needs or delete and create your own. Information on modifying
and creating items is covered in the Administrator Manual.

Access the Workbench
From the WinSales menu bar select View then Workbench or press F4 on the keyboard.
The Use tab is defaulted and contains all Workbench functions.

Workbench Functions
Query Search for data on any WinSales table(s). Results display in a spreadsheet type
grid where they can be viewed, printed, or DOUBLE CLICKED to work in the Contact and
Activity windows.
Report Automatically print formatted query results. Pick fonts, position fields and
compute totals.
Mail Merge Print a form letter or mailing label for a specific group of Contacts
Export Extract query results from the WinSales database for use in another application
such as Microsoft Excel.
Graph Create graphs showing counts, cross-tabulations and sums of amounts using
criteria of your choice. Works with data from any WinSales table.
Mass Assign Initiate a group of Contacts on an Action Plan.
Mobile Device Configuration For future use. Will be used to program devices such
as Palm and many others.
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Running pre-defined Workbench functions
Functions that come with pre-defined items are Query, Report and Export. You must
create items for all other functions.
 From WinSales open the Workbench (F4)
 Click once on the + to the left of the function to display the list of pre-defined
items.
 Click on the item you wish to run then click the Results tab or DOUBLE CLICK the
item.

Queries can be built in such a way that require you to enter information to complete the
database search.
Example: If you select a Query that is Rep specific and/or has a date range you
will see a User Defined Value window as shown here. Make selections from the dropdown lists or enter dates then click OK.
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Query Results
Query results display in a spreadsheet as shown below.

Print Results
Print results by selecting File then Print. Be sure to adjust the paper size and layout to
accommodate the size of the grid.

Work with Query Results
Work with results by DOUBLE CLICKING a line item. WinSales will open either the Contact
or Activity window for the selected item based on the cell you clicked.
Example: In the grid shown above the column headings of FirstName, LastName
, Sales Rep and Campaign are fields that reside on the Contact window. The column
headings Date, Property, Total Purchase price and Contract Stat us are fields that reside
on the Sale tab in the Activity window.
If you DOUBLE CLICK the Property cell for Randolph Wheeler, the Activity window will
display as active and the Contact window will be inactive as shown below. The Query
window will also display so that you can easily return to it as needed by simply clicking on
it.

Contact Window

Query Results Window

Activity Window
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Copy Results
When working with a Query the results may be copied to the Windows clipboard for use
in other applications such as Excel.
 Highlight the portion of the grid that you would like to copy.
 Right mouse click and select Copy (or Ctrl + C).
 Open Excel and select the top left corner record then right mouse click and select
Paste (or Ctrl + V)
The results are pasted into the Excel spreadsheet for further review.

Report
When you run a Report by DOUBLE CLICKING an item in the function list, it will
automatically print. There is no opportunity to view the results prior to printing so it is
important that you are certain of the results the report will produce. One way to
determine this is to highlight the item in the function list then click the Criteria tab to view
the Selection list of criteria then view the Layout tab. The number of results that will be
found will display in the Message Bar only after the Report has begun to run.

Criteria Tab
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Report Layout

Return To Workbench
 Select Report then Return to Workbench.

Export
An export copies a specified group of Contacts out of your WinSales database into a text
or ASCII file that can then be used in another application such as Excel.
To run a pre-defined export:
 From WinSales choose View then Workbench or F4.
 Click the + in front of the Export function to display the item list
 Double click the item to initiate the export.
Your message bar will tell you when the export is complete by displaying the number of
exports that were done.
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Export Continued
Once the Export is complete,
 Open the Options tab on the Export window to find the Output file location.
 In Explorer, locate the output file and open it.
You can now copy the contents of the file into another application such as Excel.
Instructions on building Exports are covered in the Administrator manual.
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Fulfillment Center
Overview
The following is a brief description of the Fulfillment Center. Full instructions are covered
in the Administrator manual.
The Fulfillment Center is where all scheduled correspondences are cued to be merged
and/or printed. Email and automatic faxes can be sent via the Fulfillment Center as well
as printed correspondences.
One person may be assigned to run Fulfillment on behalf of the entire company.

Access the Fulfillment Center from the WinSales Tools menu.

The Fulfillment administrator should check each day for items that need to be sent.
When all items have been sent, they will select Options then Resolve.

WinSales will automatically update each Correspondence Activity from a Status of
Scheduled to Resolved. For those items that were a step of an Action Plan, WinSales
will advance the Action Plan to the next step.
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Set Up Database Users
Adding database User names is done in the Administrator Program.
 From WinSales select Tools on the menu bar and click Administator.

 Enter Admin as the User Name.
 Enter Admin as the Password.
 Choose the OK button.

Each WinSales database can be secured by establishing a list of Users that may access
the database. Used in conjunction with Security Groups, the functions each User can
perform and the tables and fields each User can view and modify in WinSales can be
dictated. See the WinSales Administrator manual for details.
 From the Edit menu, choose Users.
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 From the User List on the right select [New User].

Admin is the pre-programmed User Name that allowed you to log into this program. SP
is the User Name that allows Silent Partner to log into your program when you call for
Technical Support and are not able to log in yourself for some reason.
 Click in the User Name field and type the new User name.
 Enter a Password if you like although it is not required.
 If you are using a MAPI-compliant e-mail system, enter the User's E-mail

Address.
Note: When connecting to this database, a User may enter their User name or e-mail
address.
 Choose the Security Group to which this User will belong within the context of
your database.
We have included three Security Groups with the program.

Admin: (Short for Administrator) This group has access to WinSales, Administrator and
Fulfillment Center.
Public: This group has access to WinSales only.
Management: This group has access to WinSales and Fulfillment Center.
If you are a single User choose the Admin group. The Admin group has global access to
everything in the database.

Creating Security Groups is covered in the WinSales Administrator manual.
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 Choose the User Site the User will log into the majority of the time.
The database comes delivered with “Corporate” as the only choice but other sites can be
added. For example; “Remote” for laptops and Palm devices, “Branch 1” for other office
locations, etc.

 Check the “Create a Sales Rep Record” box.
This will allow the User to log activities in the program. If you don’t check this box you
will not be able to save activities for a Contact under the User’s name.
 Choose the SAVE button then click DONE to close the Administrator.

Note: Editing existing Users is covered later in the Help Files.
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Importing Data
What Is An Import
The WinSales import utility allows you to import data from another application into a
WinSales database. To do so, you must first create a text or ASCII file using the data
from the other application

Planning Your Import
Before building an import in WinSales, work through the following steps:
 Create a backup of your database.
 Make sure the data you are importing is "clean". Delete duplicate records.
Delete or change incorrect data.
 Determine the attributes of the text or ASCII file created by the application. You'll
need to know whether it is delimited or fixed ASCII, the common field and record
separators, and whether or not there are quotes around string values.
 Determine the Target Window, meaning, where are you going to put this
information?
 Each element in the import file must match one element in the target window.
Example: If you are importing Contact information the Target Window will be
“Contact” and each piece of information in your import file has to fit into a field in
the Contact window.
 Required fields on the Target Window MUST have a value imported into it or
records will be rejected. Required fields in the Contact window are: Initial Mkt
Campaign, Marketing Details, and Response Method and must have a value
assigned when importing Contacts.

Defining An Import
In WinSales, choose Import from the File menu.
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The Import Plan window will display and is defaulted to the Import tab.
 Click [New Plan].

Defining the Source File
In the upper right enter:
 Name -The name assigned to the import plan you are creating.
 Style - ASCII Delimited or Fixed ASCII selected from the drop-down list.
 Target -The WinSales window you want to import to. Make a selection from the
drop-down list.

The WinSales Elements box displays a list of elements or fields of the Target window you
selected.
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 Click the Browse button on the File field and path to the source file that contains
the data you want to import.
The ‘From’ list is populated with the records contained in your source file.

Matching the Import File to WinSales Elements

 Click on a record in the ‘From’ list then the associated ‘WinSales Element’.
Example: Company in the ‘From’ list and Company Name in the ‘WinSales
Elements’ list.
Note: The names of the elements may not be called the same in each list as in this
example. Similarly, with Street 1 and Address 1. Also, you may not have an element in
the’ From’ list that is in the ’WinSales Elements’. In this illustration we are not importing a
‘Country’ field. You do not have to match every Element unless it’s a Required field.
The ‘To’ list displays the match between the ‘From‘ and ‘WinSales Elements’.


Continue until all ‘From’ records are matched with a ‘WinSales Element’ and the
‘To’ list is complete.

The only rules are that you MUST match every element in the source list to a WinSales
Element and you MUST have an element for Required fields.
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Note: When matching elements that are a Reference to a Table as in the example
above of Sales Rep and Campaign, you must click on the item within that element you
wish to match. Reference Table Elements are indicated by a + in front of it.

The Import Buttons
Process: Runs the import once it is defined.
Clear Choice: Removes an element from the ‘To’ list.
Insert Value: Adds a value to import as a constant.
Remove Field: Removes an inserted value.
Add Field: Allows you to type a value in a Required Field if you don’t have an
element in the ‘From’ list.
View Record: Lets you scroll to view additional records in the import file.
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The Options Tab
Use the Options tab to set import attributes.

Duplicates

Duplicates are detected by comparing incoming data to data already in the WinSales
database. If your incoming file itself contains duplicates, these will not be unless the
record is also already in the WinSales database
Detect Using allows you to select one of the WinSales elements matched to a From
element to check for duplicates. If you are importing into the Contact window, you may
also select MatchCode, which will use all of the elements in the list to search for a
duplicate.
When you select Skip Record, WinSales rejects any duplicate record it encounters.
When you select Update Record, WinSales updates the existing record with any value
that is different in the source file.
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Security
This feature allows you to choose Public or Private use of
the import.
When you choose Public Use all Users can see the import.
When you choose Private Use the import will only be visible
to the User who created it. This is determined by your Login
name.

Misc.
TimeStamp Checking is enabled if one of the fields being imported is a Time Stamp field
(formatted as date, a space, and time as a single field; for example: (1/1/01 9:55am). If
checked, a record is only imported if there is no duplicate or if the duplicate found has a
time stamp that is prior to that of the record being imported.
Import with Exclusive Access The purpose of restricting access during an import is to
ensure data integrity should you elect to backup, import, then restore the database back
to its original state. This could be important if you are unsure of the quality or
consistency of the incoming data. The import will occur with much greater speed if no
other users are permitted access to the database during import.
Backup Database First to create a backup of the database prior to importing records.
Highly recommended so you can recover your database if the import is corrupt.

Number of Records to Skip specifies the number of records in the source file to skip
during processing. In this example, we don’t want to import record #1 because it
contains our column headings.
Number of Records to Load indicates the specific number of records to be imported. If
you leave this field blank, all records will be imported.
You can import a partial file by specifying the records to skip and the number of records
to load.
Attributes in the source file - This should be defaulted by the file format selection to
populate the Field Separator, Record Separator, and Quotes Around Strings.
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Action Plan List

Action Plan
If you are importing into the Contact window and you select an Action Plan, WinSales
initiates the contacts on the Plan during importing.

Saving an Import
Once the import is defined, click the Save button on the control panel in the lower right
corner of your monitor. The import plan is added to the Import Plan name list.

Running an Import
 From the Import Tab, click Process.
Note: Before executing an import, it is very important to backup your data. If you missdefine the import or the data you are importing is inconsistent or corrupt, your database
will become populated with bad information.

Running an Existing Import
 From the Import Plan list click on the plan you wish to run. Click Process.
During importing WinSales first validates the data in the source file against the database
rules and displays a message informing you of the number of records that were rejected
and the number that will be imported. Check the error and reject files before proceeding.
When you click YES to proceed, the records are imported.

Reject and Error Files
When a record is rejected, it is written to a file in the same path and same name as the
source file with a .rej extension. This file contains the records that were rejected. An
accompanying file, in the same path and same name as the source file with an .err
extension, contains a message that describes why the record was rejected. If records
are rejected, you may correct them in the .rej file.
 Using the same import plan, change the source file on the Import tab to the .rej
file, then click Process.
Once the import is successfully completed find some sample records to verify that the
data imported correctly, then delete your backup of the database. See the section in the
Appendix on Importing Data With Notes if your source file contains notes with carriage
returns.
 Close the Import Window and return to WinSales. If you close the WinSales
program, log back into the Training database using the User Name and
Password of ‘Trainee’.
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Importing Data With Notes
Problem: You have Note fields in your import file and when you try to import into
WinSales, you get to a certain % and WinSales is stopping the import with a message
that you do not have Exclusive Use to the database.
Solution: Some files that you may want to import into WinSales contain Note fields
which include carriage-return/line-feed characters (record delimiters) that WinSales does
not recognize. Therefore, you need to alter the format of your incoming data before
performing the import.
There are many software tools that can be used to alter the format of your incoming data.
This tech report describes a solution using Microsoft Excel as follows:
 Start Microsoft Excel.
 Choose Open from the File menu.
 Drill to the location of your file. Click on the down arrow next to List Files of
Type: and choose All Files. Select the file and click OK.
 Add a column at the very right (end) of the file by highlighting the column (click
once at the top of the column) and choosing Columns from the Insert menu.
 Click once in the first cell of the new column and type a tilde character (~). Fill
the column with the tilde character (each row should have one).
 Choose Save As from the File menu. Click the down arrow next to Save File As
Type: and choose CSV. Enter a file name making sure to use a .CSV extension
and click OK.
 Exit Excel.

When defining the import in WinSales, be sure to specify the following:
 On the Import tab, from the Style: drop-down list, choose ASCII Delimited.
 On the Options tab, at the Record Separator: field, enter a value of 126/13/10.
 Proceed normally with the rest of your import definition.

100

Action Plans
What is an Action Plan?
An Action Plan is a pre-defined series of activities. Their purpose is to automate your
marketing and customer retention functions so you can save time. They can be
designed to send pre-written marketing information to prospects as well as keep in touch
with existing customers.
An Action Plan can be anything from a once-a-year Birthday or Anniversary card to a
semi-annual newsletter to a series of pre-written letters and scheduled phone calls.

How Do Action Plans Work?
When a Contact is initiated on an Action Plan, WinSales automatically schedules the first
step of the plan to occur. When a scheduled step has been resolved, WinSales
automatically schedules the next step in the plan and so on until the last step of the plan
has been resolved. An Action Plan can consist of one or many steps. A Contact can be
initiated on more than one plan at a time.

Note: WinSales delivers these pre-built
‘mock’ Action Plans that can be used as
templates for your own Action Plans.

Create An Action Plan
Plan The Plan
To create an Action Plan ask yourself these questions:
 -What is the purpose of the Plan?
 -What are the steps to carry it out?
 -What is the duration of the Plan?
 -What should happen at the end of the Plan?


Example: 3 Month Delayed Interest Action Plan
Purpose To keep in touch with a Prospect who isn’t ready to buy for 3 months.
Steps A series of 4 correspondences (letters, postcards, emails, articles, promotional
items, etc sent via mail e-mail, fax, etc) followed up with a phone call to see if they are
ready to buy.
Duration 90 days
Desired Result Talk to the Contact in 3 months to make a sale or decide what to do
next.
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Make An Outline










-Name the Plan.
-Name each step of the Plan.
-Decide what type of Activity the step is (Correspondence, Phone Call).
-Decide how far apart each step should occur.
-Create the documents for Correspondences.
-Add documents to the drop-down list of the Letters Directory.
-Decide how each document will be delivered (email, mail, fax, etc).
-Decide what should happen after each step is resolved.
-Decide whom each step will be assigned to.

Create The Letters
The terms ‘Letters ‘and ’Correspondence’ are interchangeable and refer to letters, emails,
faxes, newsletters, postcards, greeting cards, articles, brochures, packets, kits,
promotional items, etc that are sent to a Contact. Remember, WinSales comes with
letter templates that can be modified for this purpose. If you have existing letters you
can cut and paste the text into the WinSales merge templates. These templates are in
the WinSales program directory in the Letters Folder.
 Go to Microsoft Explorer then C Drive then Program Files then WinSales
thenLetters. There is a list of blank letters, envelopes and labels with merge
fields in them some of which coincide with the mock Action Plans.
 Open one of the letters to see the merge fields that it contains.
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Customize A Letter Template
 Use the ‘Insert Merge Field’
button to customize the fields
in your letter.
 You must use proper
punctuation and line spacing.
 Type the body of your letter.
 Format the letter to fit your
letterhead if needed.
 SAVE AS the name you want
to give this letter and make
sure it is in the Letters
Directory that WinSales will
merge from*.

Customize A Label Template
 From the WinSales Letters
Directory open the Labels.doc
template.
 Use the ‘Insert merge Field’
button to customize the fields
in your label.
 You must use proper
punctuation and line spacing.
 SAVE AS the name you want
to give this label and make
sure it is in the Letters
Directory that WinSales will
merge from*.

Customize An Envelope
Template
 From the WinSales Letters
Directory open the
Envelope.doc template.
 Use the ‘Insert merge Field’
button to customize the fields
in your envelope.
 You must use proper
punctuation and line spacing.
 Format the envelope to fit
your Letterhead if needed.
 SAVE AS the name you want
to give this envelope and
make sure it is in the Letters
Directory that WinSales will merge from*.
*See the Correspondence section in the Administrator Manual regarding Form Letter
Paths, creating your own merge letters, envelopes and labels and adding letters to your
Letters drop-down list.
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Enter The Plan In WinSales
 Choose ‘Action Plan’ from the WinSales Options menu. The ‘Define Action
Plans’ window displays. The existing Plans are shown on the left in the order
they appear in the Action Plan Tab on the Contact window.

Enter Plan Name
 In the ‘Plans and Steps’ section on the left, highlight ‘New Plan’ at the bottom of
the list.
 On the right, enter a Plan Name in the first field and click the SAVE button. Your
new plan name will appear at the bottom of the ‘Plans and Steps’ list.

Name The Step
 Click on the + to the left of the plan name to display the steps in the plan.
 Click ‘New Step’ to add a new step to the plan.
 On the right, enter the Step Name in the first field.

Activity Type
 Make a selection from the drop-down list. Choose Correspondence for this
exercise.

Lead Time For the first step it
is the number of days the step
will be scheduled to occur
after the Plan is initiated. For subsequent steps it is the number of days after the prior
step is Resolved or Canceled.
When this step’s activity is scheduled, if the computed date falls on a non-work day, the
date will be re-computed to be the next legitimate work day. By default, workdays are
considered to be Monday through Friday, but this can be changed using the item on the
Options menu.
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Activity Templates
Correspondence Template
In this example we have chosen an Activity Type of Correspondence. The following
steps show you what information to enter about a Correspondence.
 Click the Activity Template button to define how the step will be carried out. The
Activity Tab for the Activity Type you selected from this step is displayed. The
Plan Name and Step Name are automatically populated in the white Notes
section on the right. You can type additional notes to explain what this piece of
Correspondence is or what the letter talks about.
 If this Action Plan is associated with a particular Campaign, select the Campaign
name from the drop-down list in the Campaign field on the left. Leave this field
blank if the Action Plan is not associated with a Campaign.
 In the Status field, select Scheduled from the drop-down list so that when this
Action Plan is initiated this step will be scheduled.
 In the Mkt Details field, select the Marketing Details from the drop-down list that
is associated with the Campaign you selected. Leave this blank if it is not
associated with a Campaign.
 In the Method field, select how you want to send this Correspondence from the
drop-down list.
 In the Letter field, select the letter you created for this step of the Plan from the
drop-down list.
 If this Correspondence is an e-mail you must type something in the Subject field.
This will appear in the subject line of the recipient’s email.
 If this Correspondence is an e-mail and you want to send an attachment, type the
directory path location of the attachment in the Attachment field.
 If enclosures are to be included with this Correspondence, list all names of the
enclosures in the Enclosures field.
 Select SAVE.
Note: When setting up an Action Plan and associating it with a Campaign you must select
the proper Campaign and associated Marketing Details on the first step of the Action
Plan’s Activity Template.
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Activity Templates Continued…….

Phone Call Template
This Activity Template shows you what information to enter if you choose an Activity Type
of Phone Call for the Plan Step.
 The Plan and Step Names will automatically show in the Notes section on the
right. Add additional notes to prompt the person making the call what they
should talk about.
 In the Time field on the left, select a ‘non-working hour’ time to place the call.
The reason for this is twofold. First, Action Plan phone calls do not have to be
made at a specific time of day, they can be made at any time. So to schedule
these for a ‘non-working hour’ time lets the person the phone call is scheduled for
know that it can be made at any time. Second, all scheduled phone calls are
marked on the calendar of the person who is scheduled to make the call. If that
person looks at their calendar and sees it filled with phone calls, they won’t know
what time slots are actually available to make other appointments, etc.
 In the Call Type field, select Outbound from the drop-down list.
 In the Call Purpose field, select Follow Up Action Plan from the drop-down list.
 Select SAVE.
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ToDo Template
This Activity Template shows you what information to enter if you choose an Activity
Type of ToDo for the Plan Step.
 The Plan and Step Names will automatically show in the Notes section on the
right. Since a ToDo is a prompt to do something, you MUST type a note to the
person this activity will be scheduled for. Otherwise, they will have no idea what
they are supposed to do.
 ToDo’s are marked on the calendar of the person it is scheduled for. In the Time
field, select a ‘non-working hour’ time for this to occur.
 Select SAVE.

Weekday
When you finish the Activity Template you have to tell the system what day of the week to
schedule the Activity for. It is defaulted to ‘Any’ day. If the computed date of this Activity
(the Lead Time), when scheduled, does not fall on the chosen weekday, the date is recomputed to be the first weekday following. This is useful for correspondence if you want
to run certain form letters only on Mondays, or for outbound calls if there is one day of the
week on which you want to make these types of calls. Most Plans are left with the default
Weekday of ‘Any’.
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Next Steps
This tells WinSales what to do when the Status of this step changes from Scheduled to
Resolved or Canceled.
If Resolved -You may choose Next Step to move
to the next step you will create, Repeat an
existing step in the Plan** or End Plan to end the
plan.

**To repeat an existing step in the Plan creates what is called a Looping plan and is used
for things like Birthday and Anniversary cards, annual, semi-annual and quarterly
mailings, etc. Set the Lead Time for 365 on a yearly plan, 183 on a semi-annual plan,
etc. After you send out the first correspondence manually, initiate the Action Plan and
the rest will automatically schedule for the Lead Time you specified.
Note: It is recommended that the last step of a plan be an Activity that, when Resolved,
has a ‘Next Step’ wizard that will prompt the User to do something with the Contact so as
not to leave them hanging in limbo. Phone Calls and ToDo’s are good choices.
If Canceled - An Action Plan step can be
cancelled without aborting/ending the entire
Plan. In this field, select whether you want to
End the Plan or skip to the Next Step if this step
is cancelled.

Trigger
A Trigger may be attached to an Action Plan Step to ensure it will be scheduled for the
correct person. If the Plan Step is a Correspondence it is the person whose name will
appear on the letter. If the Plan Step is a Phone Call it is the person who is to make the
call.
When the Logged-In User initiates an Action Plan they become the ‘Sales Rep’ for the
activity defined by the Action Plan. This may not be the correct person for the step.
Example: An Administrative Assistant initiates an Action Plan for a Sales Rep. The
Sales Rep’s name should be on the letters, phone calls etc, but since the Assistant
initiated the Action Plan, their name will be defaulted as the Sales Rep.
OR
A Mass Assign is done through the Workbench for a group of Contacts. The person doing
the Mass Assign will have their name associated with the letters and other activities.
A trigger can be assigned to each step of the Action Plan so it automatically assigns the
Sales Rep associated with the contact instead of the person initiating the plan.
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Decipher Trigger Jargon
AP

Action Plan

Call

Phone Call Activity

Cor

Correspondence Activity

ToDo ToDo Activity

Example: APCallContactSalesRep means that if the new step were a Phone Call Activity,
this selection would schedule the call to be made by the Sales Rep assigned to the
Contact on the Contact window.
 Select whether you want the Contact Sales Rep or the Logged In Rep to be the
person this Step is scheduled for.
 Click the SAVE button.

Note: Only use Trigger items that begin with AP. These are Action Plan
Triggers. The other items in the Trigger drop-down list do not pertain to
Actions Plans.

Edit And Delete Steps And Plans
Select Options then Action Plan in the Menu bar.
 To update a Step of a Plan, click on the Step
under it’s Plan Name. Make your change to
any element of the definition including the
Activity Template.
 Click the SAVE button.
 To move a Step within a plan, click on the
Step under its Plan Name, then use the
up/down arrows to reposition it.
 Click the SAVE button.
 To delete a Step or a Plan, click on it to select it, and then choose Record from
the Edit menu, then Remove this Plan or Step.
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Action Plan Directory
It is suggested that you create Action Plan binders for your Sales Reps, which includes a
directory as shown below, and copies of each correspondence. The Reps should become
familiar with each of the plans so they know what their Contacts have received before the
scheduled phone calls. Be sure to update the binder as your Actions Plans change.

Sample Action Plan Directory -

This directory template is in the Basic Selling System Database Structure.xls file located
in your WinSales program folder. It can be modified for your own Action Plans.
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Appendix A
More Information On Installing WinSales 5.0.
Please review the WinSales 5.0 Release Notes.doc for more information on working with
WinSales 5.0. Existing customers will find the new features and functions of WinSales
5.0 in the release notes.

Installation Strategy
We recommend installing WinSales 5.0 to the C:\Program Files\WinSales\ directory on all
client machines with the database existing on a server where users share data. For
companies working with WinSales in a network environment, the software does not need
to be installed on the server where your database resides, only on the local client
machines. When installing the software on client machines we recommend copying the
installation file locally to the machine where you are installing for better performance.
You can copy the installation files to a directory on a server and run the installation from
the network, but the installation will take longer.
Customers working with WinSales 4.0 can have both versions of WinSales installed on a
client machine and running at the same time. You must install the WinSales 5.0 software
on the client machines to a different location than where WinSales 4.0 is located or you
would over write files. By having both versions installed you will be able to use WinSales
4.0 while evaluating WinSales 5.0. Existing customers using remote synchronization
should beware that running synchronization on a copy of their database converted
to WinSales 5.0 without changing the SyncPath will create the same
synchronization files and overwrite existing copies of the 4.0 files in the SyncPath
directory. Change the SyncPath for users in the 5.0 master and remote database
before evaluating remote sync to avoid any issues with the live database!

System Requirements For Installation
Hardware requirements and recommendations: To install WinSales 5.0 you
must have at least 25mb of free space on the hard drive. The minimum machine
requirements are a p200 with 64mb of RAM. We recommend p450 or higher with at least
128mb of RAM.

Win95 requires Outlook 2000: To install WinSales 5.0 on a Win95 machine Outlook
2000 must be installed.

Microsoft Data Access Control (MDAC) requirements: WinSales 5.0 will force
the installation of MDAC v2.6 and Jet 4, which requires Microsoft Internet Explorer 4.01
service pack 2 or greater. If users are not currently running IE 4.01 service pack 2 they
will be forced to upgrade before installing WinSales 5.0. To download MDAC v2.6 go to:
http://www.microsoft.com/Data/download_26sp1.htm
Windows 95/98/ME: WinSales 5.0 will install Dcom98. Dcom98 can be downloaded
from http://windowsupdate.microsoft.com/.

Windows 2000 users will be required to have Service Pack 1. However, we strongly
recommend Service Pack 2, which can be downloaded from www.microsoft.com.
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Windows XP & 2000 users installing WinSales 5.0 only installs the program for the
profile of the user logged on to the machine. Other user profiles will also need to install
WinSales 5.0.
Internet Explorer 5.0 is required for support of WinSales 5.0 features linking to
Internet Explorer. Silent Partner strongly recommends Internet Explorer 5.5, which can be
downloaded from http://windowsupdate.microsoft.com.

Installing WinSales 5.0
Remember to shut down all other programs on the machine before starting the WinSales
5.0 installation. To install WinSales 5.0 navigate to the location of the installation file and
double click to run. You will see the Windows Installer start the installation process.

If your machine is running an older
version of the Windows Installer it
must be updated to install WinSales
5.0, and you will receive the
message:

If you choose to restart after the
Windows Installer has been updated
the WinSales 5.0 installation will
automatically continue once you are
back in Windows. If you choose to
not reboot you will need to go back
to the install folder later after
restarting the machine later and run
the WinSales 5.0 install from the
SETUP.EXE and the install will
begin immediately.

The WinSales 5.0 installation will
check the version of MDAC the
machine has installed and if it is not
running v2.6 sp1 or higher the
program will install those
components for you. Click YES to
update the MDAC, clicking NO will
abort the installation process.
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Once the MDAC update is
complete the InstallShield
Wizard will guide you
through the installation
process.

 Click the Next button
to continue with the
installation.

The License Agreement is
the legal agreement between
the user and Silent Partner.
 Click the “I accept the
terms in the License
Agreement” choice
after reviewing the
details to continue the
installation. If you do
not agree to the
License Agreement
the installation will be
cancelled.
 Click the Next button
to continue the
installation.

The Destination Folder
window allows you to select
the directory to install the
software by clicking the
CHANGE button, or take
the default installation
directory and click the Next
button to continue the
installation.
 Click the Next button
to continue the
installation.
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You are now on the Ready

to Install the Program
window where you click the
Next button to start the
installation.
 Click the Install button
to continue the
installation.

Once you click the Next
button the Installing
WinSales 5.0 window will
appear and the program will
run the installation.

When the installation is complete, if the MDAC files were updated you will receive a
message to restart the computer for the changes to take affect.
 Close all other
applications and click
YES and the machine
will restart and the
installation will
continue.
If you click NO the next time
the machine is restarted the
installation will continue.
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Once the InstallSheild Wizard Completed window appears you have successfully
installed WinSales 5.0.

 Click the Finish button
to close the
installation program
and begin using the
program.

Re-installing Or Uninstalling WinSales 5.0
When the install is run on a machine where WinSales is already installed you will get the
below window advising the software is currently installed and preparing the InstallSheild
options Repair or Remove the program.

Clicking the Next button will
bring up the options to Repair
(re-install) or Remove the
program.
 If you wish to reinstall select Repair
and then click Finish
and the program will
update the files so
that you are current
with the latest
installation of
WinSales.
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Selecting REMOVE will
cause the program to launch
the un-install routine to
remove WinSales 5.0 from the
machine.
 Select the Repair to
re-install the program
or the currently
installed version to fix
any problems with the
installation.

 Click REMOVE and
once the un-install
program has
completed WinSales
5.0 has been
removed from the
machine.

Installation Notes
Wrong version THREED.OCX after install: After installing WinSales 5.0 on a machine
with an earlier version of THREED32.OCX registered you are being asked to upgrade
when you attempt to open a Visual Basic Project. WinSales 5.0 installs THREED20.OCX
and registers the file. Projects using THREED32.OCX will generate error messages
because the file is no longer registered. The work around for this issue is to use the
REGSRV32.EXE program to un-register and re-register the earlier version of
THREED32.OCX (which WinSales 5.0 will function with). See Infragistics Knowledge
Base Article 3DF7 for more information:
http://www.infragistics.com/support/knowledge/article.asp?artid=7&ProdName=Sh
eridanGeneral&ProdCode=SGP
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Appendix B
Create Your Own Training Database
To create a training or practice database from your own live database follow these steps.

Step One – Locate your live database
Right mouse click the
button in the lower left corner of your monitor, select
Explorer and locate your database.
Your database is indicated by the .wsd extention which stands for winsales database.
The example below is for illustration purposes only. Your database location may be
different. If you do not know where your database is located, contact your WinSales
Administrator or IT department.
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Step Two – Make a copy of your database.
Highlight the database .wsd file and right mouse click to select ‘Copy ‘ then ‘Paste ‘.

OR
Highlight the database .wsd file and press Ctrl+C then Ctrl+V on your keyboard.

Step Three – Re-name the database
Highlight the copy and right mouse click to select Rename then add ‘training’ to the
name.

Step Four – Connect to the new training database
In the WinSales log in window, type the name you want to call your training database in
the database field. You can type over an existing name in the list and it will not delete or
change that database.
 Enter your User Name and Password as you normally do.
 Click the ‘Add Name to List’ box to add it to the Database field drop-down list.
 Click OK.
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Step Five – Path to the database location.
You must tell WinSales where this new database is located then open it. When you click
OK in step four, you are taken to the Explorer window.
 Click the appropriate drives, directories, folders and files until you reach the
training.wsd database you created in steps two and three.
 Hightlight the file as shown below and click Open.
You will then be connected to the new training database and the name will be in the
database drop-down list next time you log on to WinSales.
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E
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Export
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F
Find
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I
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N
Next Step, 32
O
Opportunity
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Q
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R
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S
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Search
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